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Getting Started

The IBM® Sterling Gentran:Director® Forms Integration subsystem
provides you with the tools you need to design formsto facilitate the keying
and printing of EDI documents.

What's in this Manual

The majority of the Sterling Gentran:Director Forms Integration
documentation is contained in the online Help system. This manual supports
the online Help by assisting you in performing various tasks in the Forms
Integration subsystem. This task-oriented approach is intended to answer
any questions you may have about Sterling Gentran:Director with step-by-
step instructions.

Thismanual assumesthat you arefamiliar with usinga
PC and with Microsoft® Windows functions,

including:

. Theterminology used to describe mouse and
cursor actions.

. Theterminology used to describe Windows-

specific attributes, including dialog boxes, icons,
windows, and buttons.
. Using the Windows Program Manager.

This manual also assumesthat you are familiar with
EDI concepts, EDI standard structure, your internal
application format, data mapping concepts, and with
the Serling Gentran:Director product.

The IBM® Serling Gentran: Director® Forms Integration User Guideis
organized into chapters. A brief description of the chapter contents follows.

e Chapter 1, Getting Sarted explains the content, organization, and
conventions in this guide, as well as the system requirements. This
chapter also describes how to get technical support, provides a brief
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What's in this Manual

Getting Started

2 May 2011

outline of how to build forms using Sterling Gentran: Director, and gives
you an introduction to the Forms Integration subsystem.

Chapter 2, Forms Basics explains how to perform basic functionsin
Sterling Gentran:Director, including creating a new form; using EDI
files; opening, saving, and naming aform; compiling atrandation
object, and printing areport. This chapter also explains customizing
display options; setting the default date format; selecting which form
components to use; cutting, copying, and pasting; setting up the
document name and reference; and formatting your data.

Chapter 3, Customizing the Properties of Form Components explains
how to customize the properties of segments, looping structures,
elements, and composite el ements. This chapter also explains how to
use loop start (LS) and loop end (LE) segments.

Chapter 4, Using Sandard Rules explains how to use the Sterling
Gentran:Director standard rules: select, update, constant, use accum,
loop count, and use code. This chapter also illustrates examples of when
you might use certain standard rules.

Chapter 5, Using Extended Rules defines what extended rules are and
when they are used, and explainsthe proprietary programming language
syntax.

Chapter 6, Customizing Screen Entry Translation Objects explains how
to customize screen entry translation objects, including customizing
field labels, setting an initial value for afield, setting a constant value
for afield, creating definitionsfor alist, and creating Help text for fields
and listes. This chapter also defines how to format the variousfield
types, how to hide fields, and how to store EDI code value descriptions.

Chapter 7, Customizing Print Translation Objects explains how to
customize print translation objects in Sterling Gentran:Director,
including customizing field labels, hiding fields, and formatting the
various field types.

Chapter 8, Formatting Screen Entry and Print Translation Objects
explains how to format the organization and size of the fieldsin the
tranglation object.

Chapter 9, Error Messages describes Sterling Gentran:Director error
messages and specifies corrective actions.

The Glossary contains definitions of Forms Integration and Sterling
Gentran:Director terms and concepts.

The Index provides you with alist of terms, concepts, functions, and
processes to enable you to quickly find them in this guide.
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Getting Started What’s in this Manual

Conventions in
this Manual Thedifferent typefaces used in this manual are as follows:

Creatinganewform  Thistypefaceisused for emphasisor to indicate a
chapter or section in this manual or other Sterling
Gentran:Director manuals.

NEW.. This typeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, then press ENTER
to execute that command.

F1 Thistypeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a combination of keysto be
pressed together (e.g., ALT + TAB).

Click this button This typeface highlights an action that you should
take or indicates descriptive text. It is most often
used for callouts (text that is“ pulled out” to the side
or bottom of an illustration) in this manual to
highlight specific steps that you need to taketo
complete atask. In the callouts, any button that you
need to click is described in this same typeface.

The different icons used in this manual are as follows:
Thisicon indicates a note that gives you additional
information on the current subject.
potential loss of information. Pleaseread any text

preceded by thisicon carefully.

Thisicon indicates helpful tips, suggestions, shortcuts,
and alternative actions.

@ Thisicon indicates a caution that alertsyou to the

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 3



Getting Support Getting Started

Getting Support

IBM’s Sterling Gentran:Director software is supported by trained product
support personnel who are available to help you with product questions or
concerns. To help us provide prompt service, we ask that you do the
following:

» Attempt to recreate any problem that you encounter and record the exact
seguence of events.

e Make copies of the tablesin the following sections so that you can enter
the regquested information and have it available when you call us.

For assistance, please refer to your Getting Support card to determine which
support phone number you should use.

When you call product support, you should be prepared to provide us with
the information bel ow.

To help us provide prompt service, we ask that you do the following:

» Attempt to recreate any problem that you encounter and record the exact
seguence of events.

e When you call product support, you should be prepared to provide us
with the information below.

1. System Configuration:
Information about the primary system controller and all machines
experiencing problems, including the computer manufacturer and
model number, Windows version, amount of memory, available
disk space, and the network adapter type.

2. Error Messages:
Record the exact wording of any error messages you receive and
the point in the software where the error occurred.

3. Attempted Solutions:
Record any steps that you took attempting to resolve the problem
and note all the outcomes.

4 May 2011 IBM Sterling Gentran:Director Forms Integration User Guide
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Introducing Forms Integration

Introducing Forms Integration

EDI File Format
Window

A formisaset of instructions you define in the Forms Integration subsystem
that indicates how the system should format data. When you compile the
form, Sterling Gentran:Director generates a translation object. After you
register the translation object with Sterling Gentran:Director and associate
the trandlation object with a partner relationship, the system uses the
tranglation object to format EDI documents. The Forms Integration
subsystem enables you to create print and screen entry translation objects.

A print translation object organizes and formats the printout of EDI
documents that are received from or sent to the trading partners for which
you have established a trading relationship (inbound or outbound) that
utilizes that print translation object. The print translation object enables you
to view the EDI document in an easily readable format.

A screen entry translation object provides a standardized format for keying
an EDI document into the Document Editor, for translation and transmission
to your trading partners, for which you have established an outbound trading
relationship that utilizesthat screen entry translation object. The screen entry
trangation object ensures that your users key all the data necessary to create
the required EDI document.

Regardless of whether the translation object is print or screen entry, Sterling
Gentran:Director generates the actual format of the translation object based
on the EDI file format (in the EDI File Format Window), and displaysit in
the Layout Window.

The EDI File Format Window (left side of the Forms Integration subsystem
main window) containsthe EDI file format. The EDI file must contain all the
information that you need to include to either create a document using the
Document Editor (screen entry translation object) or print documents (print
translation object), so that your system can accurately process the data.

Sterling Gentran: Director generates an EDI file for you, based on the
standard (agency), version, transaction set, and release (for the
TRADACOMS standard only) you selected. The system includes all the
groups, segments, composites, and elements that are defined by the
standards agency for the version of the document you selected. Please see
Creating a New Form on page 16 for more information on generating an EDI
file when you create a new form. You typically need to customize the
system-generated EDI file by modifying the properties of the form

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 5



Introducing Forms Integration Getting Started

components, and using specialized Sterling Gentran:Director functions to
manipulate the EDI file structure.

However, if you want to use aspecialized version an EDI standard that is not
available in the Sterling Gentran:Director standards database, it may be
appropriate for you to define the EDI file yourself.

Regardless of whether the system generates the EDI file or you defineit, the
specific EDI form components that you use depend on the type of form you
are creating. Thisincludes the standard, version, and transaction set
(document) selected, and which groups, segments, composites, and elements
your company requires. We recommend that you determine which form
components you are using before generating or defining an EDI file.

The form components that Sterling Gentran:Director uses to define the EDI
file format are as follows:

e A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is alowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a sub-group (this correspondsto a nested
looping structure —aloop within aloop). The EDI file isagroup and
therefore, it isvisually represented the same way as other groups and
sub-groups in Sterling Gentran:Director:

* A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times. A segment is visually represented in Sterling
Gentran:Director as the following: ‘.

A compositeisadataelement that contains two or more component
data elements or sub-elements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards). A compositeisvisually represented in Sterling
Gentran:Director asthe following: g

* Anéement isthe smallest piece of information defined by the EDI
standards. Anindividua element can have different meaning depending
on the context. Therefore, elements are normally not considered to have
useful meaning until they are combined into segments. An element is
visually represented in Sterling Gentran:Director as the following: -

When an element has an operation performed against it, ared checkmark is
displayed over the element icon.

6 May 2011 IBM Sterling Gentran:Director Forms Integration User Guide



Getting Started

Introducing Forms Integration

Layout Window

Please see Using an EDI File Format on page 20 for more information on
customizing the properties of the form components, and using specialized
Sterling Gentran:Director functions to manipulate the EDI file structure.

The Layout Window (right side of the Forms Integration subsystem main
window) contains the actual format of the trandation object. Sterling
Gentran:Director uses frames to format the EDI file for the translation
object. Each frame contains the groups, repeating segments, and elements at
that level (single segments are not represented on the frame).

For screen entry translation objects, groups (with a maximum usage greater
than one) and repeating segments are formatted aslists. Elements are
formatted as edit boxes (fields) or lists on the frame. Elements typically are
formatted as fields, but are formatted asalist if you apply a standard rule
that allows a selection of multiple items. Each group and repeating segment
also has a corresponding frame that contains all the groups (with amaximum
usage greater than one), repeating segments, and elements at that level.

For print translation objects, groups, repeating segments, and elements are
always formatted as fields. Each group and repeating segment also hasa
corresponding frame that contains al the groups (with a maximum usage
greater than one), repeating segments, and elements at that level.

When you click a segment or group in the EDI File Format Window, the
corresponding frame is displayed in the Layout Window. When you click an
element in the EDI File Format Window, the corresponding layout
component is highlighted in the Layout Window.

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 7



Introducing the Forms Integration Subsystem Getting Started

Introducing the Forms Integration Subsystem

The Sterling Gentran:Director Forms Integration subsystem enables you to
design forms to facilitate the keying (screen entry) and printing (print) of
EDI documents that you receive inbound or send outbound.

Navigation

The Sterling Gentran:Director Forms I ntegration Window allows you to
access its functionality in four different ways, as follows:

Click the menu option from the Main Menu Bar.
Click the appropriate button on the Main Toolbar.
Click or double-click the appropriate part of the form.

Click aform component (EDI File Format Window or Layout Window)
with the right mouse button to access a shortcut menu that contains al
the functions that are currently available for that form component. The
shortcut menus enable you to quickly and easily access available
functionality. The content of the shortcut menus vary, depending on the
type and level of the selected form component.

When you start Serling Gentran:Director, the Main
M enu Bar contains a subset of menu items. The full set

8 May 2011

of menu itemsisdisplayed after you create a new form
or open (load) an existing form.
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Getting Started Introducing the Forms Integration Subsystem

The Sterling Gentran:Director Forms I ntegration Window appears as
follows:

Control Menu Title Bar Minimize/Maximize Buttons

Z GEMTRAN:Director - Forms Integration - [pet_810s_stp]
__%& File Edit Functions View Display Options ‘wWindow Help

D|=d| g 4] ==6m] S5 0@ w5 <] MFTE
81D'M'|NVDIEE \ IIIIIIIIIIl'llIIIIIII|2IIIIIIIIIIJIIIIIIIIIII‘IIIIIIIIIsIIIIIIIIIIEIIIIIIIIITI

BIG - 1 BEGINNING SEGMENT FOR INVO ANSI X12 Invoice (810] . Pet Zane =
Imvoice Mo. I:I
REF -C- 1 REFEREMCE MUMBERS
FE 0100_N1:2 +4-1
HED 0100 M1:3 -1 Contract Ho. I:I —

&

ITD -C-1 TERMS OF SALE/DEFERRED TEF Ship To
DTM -C- 1 DATE/TIME REFERENCE

Femit Ta |
e - | :
R — L|_I RN on
For Help, press F1 l_ MHLIM 4
EDI File Format Window Layout Window
— Main Menu Bar Status Bar Main Toolbar —

e The Control Menu contains the following commands. Restore, M ove,
Size, Minimize, Maximize, and Close.

» TheTitle Bar containsthe name of the application. You can use thisto
move the position of the Forms Integration window on your desktop.

*  The Minimize icon reduces the window to an icon.

The M aximizeicon enlarges the window to its maximum size.
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Introducing the Forms Integration Subsystem

Getting Started

Open...
Cloze
Save
Save Az

n TheMain Menu Bar contains the following drop-down menus
(detailed descriptions of each of the commands on these menus are
found in the online Help). Unavailable items are dimmed.

Crl+M

Crl+0

Ctil+5

Compile

Frirt...
Frint Setup...
Frint Ta Eile...

Crl+P

1 DAGENSRYNTA,. \Pet_810s 3tp
2 D:AGEMSRYNTY...\Pet_850p.stp

Exit

Copy
Paste

Create Sub

Inzert 3

Properties

Constants
Segzion Rules
Syntax Tokens
Code Lists

Detailz

Find...

Date Formats...

Tile
Amnange lcons

v 1 Pet_850stp

Activate
Deactivate

v Statusz Bar

Expand Branch
Expand Al
Unexpand Eranch

Show Active Only

Maxinize Tree
b amimize Layout
Rearrange

Index
Using Help

About GEMTRAM:Server - Farms Integration...
Set Tab Order
Add Text
Delete Text
Align Contrals ¥
Space Evenly ¥
Size Equally
Size To Length
n TheMain Toolbar givesyou accessto some of the most common
operations in Sterling Gentran:Director. Unavailable items are dimmed.
The Main Toolbar is a dockable toolbar, so you can affix it to any edge
of the client window. The Main Toolbar isillustrated below:
Tree Only
New Cut Constants Split Add Text Change
‘ Save Paste Code Lists ‘ Deactivate Un‘do View
) =2 = o |EE | =] RS :i|ﬁ||f9|@|fh||ﬁf'|ﬂ|§z|_\IITEE
Op‘en Copy Syntax Activate Lock Labels Layout
) ~ Tokens Only
Compile Session Promote Generate Redo
Rules Layout
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Introducing the Forms Integration Subsystem

Keyboard
Techniques

o
Ei]

The EDI File Format Window containsthe EDI file format. When you
click asegment or group in the EDI file format, the corresponding frame
is displayed in the Layout Window. When you click an element in the
EDI file format, the corresponding layout component is highlighted in
the Layout Window.

The Layout Window contains the actual format of the trandation
object. Each group (with a maximum usage greater than one) and
repeating segment has a corresponding frame in the Layout Window.
When you click a segment or group in the EDI file format, the
corresponding frame is displayed in the Layout Window. When you
click an element in the EDI file format, the corresponding layout
component is highlighted in the Layout Window.

The Status Bar displays statusinformation about a selection, command,
or process, defines menu items as you highlight each item in the menu,
and indicates any current keyboard-initiated modes for typing (e.g.,
CAP for the “Caps Lock” key, NUM for the “Num Lock” key, etc.).

The procedures in this manual are designed to be executed with amouse. If
you prefer to use the keyboard instead of the mouse to click a desired menu
option, you may also pressthe ALT key and the underlined letter of the
desired menu option to open the menu. Once the menu is open, pressthe
underlined letter of the desired menu option to access that option.

If akey combination (e.g., CTRL + N for the NEW
command) is specified on the menu for that option, you
may pressthat key combination aswell.

Instead of clicking a button to execute a command on a
dialog or browser, you can press TAB to highlight the
desired button and pressENTER to execute that
command.
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Building a Form with Forms Integration

12

This section defines how to proceed with building aform using the Sterling
Gentran:Director Forms I ntegration subsystem.

1

May 2011

Prepare and Analyze

Obtain alayout of how you want the document displayed and determine
how it corresponds with the EDI standard you are using. Determine
which operations need to be performed to generate the required layout.

Set Global Defaults (first time only)

The first time you use the Sterling Gentran:Director Forms Integration
subsystem, you should establish the default date format that the system
will use. Please see Setting Default Date Format on page 65 for more
information on setting the global date default.

Create, Save, and Name a New Form
Please see Creating a New Form on page 16 for more information on
creating, saving, and naming a form.

Activate the Appropriate EDI Groups, Segments, and Elements
Please see Selecting Which Form Components to Use on page 67 for
more information on activation.

Define the Layout of the Form

Please see Using an EDI File Format on page 20 for more information
on customizing your EDI file, including setting the EDI delimiters.
Please see Chapter 4, Using Standard Rules for more information on
using standard rules. Please see Chapter 6, Using Extended Rules for
more information on using extended rules.

Compile the Trandation Object

Please see Compiling a Translation Object on page 42 for more
information on compiling the tranglation object and translation object
naming conventions.

Print the Report
Validate and review the form, and make modifications as needed. Please
see Printing a Report on page 44 for more information on printing the

report.
Register the Trandation Object with Sterling Gentran:Director

Please see the IBM® Serling Gentran: Director® Forms Integration
User Guide for more information on registering trandlation objects.

IBM Sterling Gentran:Director Forms Integration User Guide



Getting Started Building a Form with Forms Integration

9. Createthe Appropriate Trading Relationship
Establish the appropriate trading relationship in Sterling
Gentran:Director for your trading partners. Please see the IBM®
Serling Gentran: Director® Forms Integration User Guide for more
information on creating trading rel ationships.

10. Testing the Trandlation Object
For a screen entry trangation object, create a new document in the
Document Editor, using that translation object. For a print translation
object, print adocument. Verify that the output is correct.

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 13
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Form Integration Basics

This chapter explains some of the basic (not lengthy) form integration
functions. Some of the functions are performed initially (creating aform),
some are performed as you define the form, and some are performed after
the form is completed (compiling and printing areport).

This chapter includes the following topics:

e CreatingaNew Form

» Using an EDI File Format

e Opening aNew Form

e SavingaForm

 NamingaForm

» Compiling a Form

e Printing a Report

e Customizing Your Display

e Setting the Default Date Format

»  Selecting Which Form Componentsto Use
»  Cutting, Copying, and Pasting

»  Setting Up the Document Name and Reference
*  Formatting Your Data

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 15
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Creating a New Form

You can create two different types of forms. Screen Entry (for keying
documents in Document Editor) and Print (for printing documents). The
initial procedures for creating a new form of both typesis the same.

Complete the following steps to create a new form:
1. Select New from the File menu to display the Create New Translation

Object dialog.
Function | Screen entry g |

" Create from Filz Definition...

[
% Create from EDI Standards. . TEEncel

Data Source | =l
fgency | =]
Version) | =
Tjiarsaction | |
Beemse [

[ s

I Browse,..

2. Fromthe Trandation Object Function list, select the type of form. Valid
values are “ Screen entry” or “Print.”

3. If youwant to create the form from an EDI Standards database, click the
"Create from EDI Standards..." option and continue with step 4.

If you want to load aform from a previously-saved file definition, click
the "Create from File Definition" option and continue with step 9.

From the Data Source list, select the ODBC data source you wish to use.

Select the EDI standard you are using for the input side of the form from
the Agency list. Valid values are;

[A] TRADACOMS
[E] EDIFACT

[O] ODETTE

[T] TDCC

[U] UCS/WINS
[X] ANSI X12
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10.

Select the version of the standard from the Version list. The versions
that are available depend on which standard you selected.

Select the transaction set (document or message) from the Transaction
list. The transactions that are available depend on which standard and
version you selected.

For TRADACOMS only, select the release number of the version that
you are using from the Release list. The releases that are available
depend on which standard, version, and transaction you selected.

In the Create from File Definition box, type the path and file name that
you want to load or click Browse... and the Open File Definition dialog
isdisplayed.

The“Look in” list should reflect the drive\folder where Sterling
Gentran:Director Forms Integration isinstalled.

The default is DirectorConnection\Bin. If the current folder is not the
correct one, select the appropriate folder.

Select the type of file that you want to display from the “Files of type”
list. The default file extension is .IFD.

Select the file definition that you want to load into the system from the
list. Double-click the filename or click OPEN to load the selected file
format definition.

Click OK to generate a new form (this may take afew seconds). The
new form is displayed in the Sterling Gentran:Director - Forms
Integration Window.
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11

After you create anew form, it isimportant to define the details of the
form and saveit. Select Save from the File menu to display the
Tranglation Object Details dialog.

Tranlalivn Nigead Teelailc

rSummery

by khor Diezclipion Traredation Object Functon Bpetem
Scieen ent 2| C
I I e |—I | LCancel I
~emon Conbrot

Major walgion IEI Minar version IEI I:nrrpiladunl

Agency

‘erzmn

EDI Associaliohs

Trameachon |[M¥OIC | |INVOICE MESSAE | [INVDIC | IMVIICE MESSAG

Irput Output

IE_ [[Editzct IE_ [ Ediact

|naa:u1 |EDIF.¢=.|:T1EEEF|EL |n5rauu1 |EDIFACT1EIE|2FIEL

Releae= IEI IEI
rwon [ |

12. Complete the Author box. This box typically contains the name of the
person who created the form.

13. Complete the Description box. This box must be unique because it is
used by the system to identify the form. We recommend that you use the
following identifying characteristics: the partner that thisform is used
for, the standard, the version, the type of transaction this form uses, and
the type of form. For example, “MWT X 3030 850 Print” isthe
description of a print translation object used to print documents for
partner MWT, for an ANSI X.12 version 003030 Purchase Order (850).

14. Verify the type of trandlation object in the Translation Object Function
list.

15. Click the System check box if you want to designate thisform asa

system tranglation object (one that is used internally by the system).

You should only select thischeck box if you arecertain
to want to define thistrandation object asa system

May 2011

translation object. Once a trandation object is
registered with Serling Gentran:Director, it cannot be
deleted.
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16.

17.

18.

19.

20.

21.

Complete the Mgjor and Minor boxes if you want to designate aversion
number for thistranglation object. Typethe version number in the Major
box and the rel ease number in the Minor box.

The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain the EDI format. You can change the information
in these boxes, but it will not ater the content of the form. You may
wish to alter these boxesiif, for example, you want the form to reflect a
standards version that is not loaded on your system. You can change the
version on this dialog, and then alter the form to be compliant with that
version.

Click OK to save the trandlation object details and access the Save As
dialog.
Save As

Save in: I 5] Foms

Filz name:  [INVOIC.stp

Save as type: IForms [* atp] j Cancel |

We recommend that you store forms in the translation object folder
where Sterling Gentran:Director isinstalled.

Type the name of the form (one to eight characters) in the “File name”
box. The default file extension is .STP.

Click SAVE to save the form.

After you finish creating and saving a new form, you need to customize the
EDI file format and generate the form. The steps you take are different,
depending on whether the form is a screen entry or a print form.
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Verifying EDI
Delimiters

Sterling Gentran:Director generates an EDI file format for you, based on the
standard (agency), version, transaction set, and release you selected. The
system includes all the groups, segments, composites, and elements that are
defined by the standards agency for the version of the document you
selected. Please see Creating a New Form on page 16 for more information
on generating an EDI file format when you create a new form. You can
modify the system-generated EDI file format by modifying the properties of
the form components, and using the promote, split, copy, cut, and paste
functions.

However, if you want to use a specialized version of an EDI standard that is
not available in the Sterling Gentran:Director standards database, it may be
appropriate for you to define the EDI file format yourself.

Regardless of whether the system generates the EDI file format or you
define it, the specific EDI form components that you use depend on the type
of form you are creating. Thisincludes the standard, version, and transaction
set (document) selected, and which groups, segments, composites, and
elements your company requires. We recommend that you determine which
form components you are using before generating or defining an EDI file
format.

If you are using an EDI standard that contains composite elements or sub-
elements, you must verify that Sterling Gentran:Director is specifying the
correct delimiters. Delimiters are flags that you define to the system as
separating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the datais compressed (and the
leading zeroes and trailing blanks are removed). Since the fieldsvary in
length, the system needs a flag to determine where one element ends and
another begins. For example, an element delimiter marks the beginning of a
new element.

Although verifying EDI delimitersin Sterling
Gentran:Director ismandatory only if you are using a
standard with composite elementsor sub-elements, we

recommend that perform thistask regardless of which
standard you use.

May 2011 IBM Sterling Gentran:Director Forms Integration User Guide



Form Integration Basics Using an EDI File Format

Complete the following steps to verify EDI delimiters:

1. Click the EDI fileicon with the right mouse button to access the
shortcut menu. Select Properties... from the shortcut menu to display the
File Format Properties dialog.

(D ey Diefimiters...

Desc |PURCHASE OADER
Laop Corkiol Ponms_|
bim Llzage M ap Lzage
| | ]

[T Pomote goup o parent lrame

Frama Caplioh I
Lt Coptin |
Flama Halp Taxl Liztbret Help Taut
e.d +*
+ +
+ 1 + = -
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2. Click DELI M TERS... to access the Delimiters dial og.

[ Steam segments

T ag Delimiter

Sagmant Delimilsr

Element Delimiter

Sub Element Delimiter I;

D ecimal Separator I
Releaze Character I

3. Verify the required delimiters for the EDI standard you are using. If the
delimiters differ from the defaults in the table below, type either the
character or the hexadecimal value in the correct box.

4. Click OKto exit the File Format Properties dialog.

Saving a File sterling Gentran:Director enables you to save an individual file format
Definition definition so that you can use it asaguidein future forms. This providesyou
with aquick way to build your form. Thisfile format definition can also be
used to create a new map using Application Integration.

Complete the following steps to save an individual file format definition:

1. Usetheright mouse button to click the fixed-format icon (either the
INPUT or OUTPUT side of the map) to access the shortcut menu.
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2. Select Save File Definition As... from the shortcut menu. The Save File
Definition dialog is displayed.

Save File Definition

Save in: Ia Bin

File: name: |E921_DF|D.IFD

Save az type: IFiIe Definitions [*.1FD] ﬂ Cancel |

3. The“Savein” list should reflect the drive\folder where Sterling
Gentran:Director isinstalled. The default is DirectorConnection. If the
current folder is not the correct one, select the appropriate folder.

4. Select thefile definition from the list or type the name of thefile
definition (one to eight characters) in the “File name” box. The default
file extensionis.IFD.

5. Click SAVE to save the file definition.

Creati NQg a A group contains related segments and/or groups that repeat in sequence
Grou p until either the data ends or the maximum number of times that the loop is
allowed to repeat is exhausted. If you create a group that is subordinate to
another group, this correspondsto a nested looping structure (aloop within a
loop).

Complete the following steps to create a group:

1. Tocreateagroup that isat the samelevel asa selected form component,
highlight the form component and select Insert from the Edit menu.
Select Group from the cascading menu.

OR
To create a group that is subordinate to a selected form component,

highlight the form component and select Create Sub from the Edit
menu. Select Group from the cascading menu.
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The Group Properties dialog is displayed.

Adertfication
|
e |
Loop Cortial e
Min Lizaga Mak Lzaga
. 1 Rules. . I
Displap
[™ Pramcte goup la parehk [rame
Fiame Caplion I
Lizt Captian |
Fiare Help Tewl Listheed Help Teat
el i
+ +
+ =+ = -
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In the Name box, type the segment |oop identification code.

Do not use spaces or dashes (-) in the Name box. You
can usethe underscore () to separate words.

In the Desc box, type the loop description. This box isused to provide a

brief explanation of the loop.

In the Min Usage box, type the minimum number of timesthe loop must
be repeated. For a conditional loop, the minimum usage should always
be“0” (zero). For amandatory loop, the minimum usage should be “1”

or greater.

In the Max Usage box, type the maximum number of times the loop can

be repeated.
Click OK to create the group.
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Modifying

Grou [p A group contains related segments and/or groups that repeat in sequence
P rop erties until either the group data ends or the maximum number of times that the
loop is allowed to repeat is exhausted. If you create a group that is
subordinate to another group, this corresponds to a nested looping structure
(aloop within aloop) Complete the following steps to modify the properties
of agroup:

1. Click the group you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Group Properties dialog is displayed.

laroup Fraporicz

dertfication
Mame |EE‘I]EIJ.|H
e |
Laop Cortiol Fiomats I
klin Uzage M ak Uzage
IEI IED[IIIEI m
Dieplay

I Promcte goup 1o parant lieme

Fiamra Caplion IEEDIJ_IJn

List Cotion |2zou_in

Fiamma Help Tanl Ligtbeet Halp Taut

I
| =

+[ 1 + a -

2. If youwant to modify the group name, type the new group namein the
Name box.

If a segment or element occurs morethan oncein a
form it isidentified by itsname <ID>. The second and
subsequent occurrences are identified by <ID>:n,
where“n” isthe number of the occurrencein theform.
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3. If you want to modify the group description, type the new description in
the Desc box. Thisbox is used to provide a brief explanation of the loop.

4. Inthe Min Usage box, type the minimum number of timesthe loop must
be repeated. For a conditional 1oop, the minimum usage should always
be“0" (zero). For amandatory loop, the minimum usage should be “1”
or greater.

5. Inthe Max Usage box, type the maximum number of timesthe loop can
be repeated.

6. Click OK to save the changes to the group.

Modifying
Seg ment You can modify the properties of any segment, including the minimum and
P rop erties maximum number of times the segment can repeat, whether the segment is
mandatory or conditional, and whether it isaloop start or loop end segment.
Please see Using Loop Sart and Loop End Segments on page 80 for more
information on using loop start and loop end segments.

Complete the following steps to modify the properties of a segment:

1. Click the segment you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.
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The Segment Properties dialog is displayed.

Seguimnl Pospenlivy

dertfcation —
Mame |BEG I Birary [ Use Key Field
Desc |EEEINNINE SEGMENT FOR FURCHASE OADER | Fey Figd... I
| Framate I
rLaop Corhial
blin Uzage M ak Uzage
|1 |1 ® Momal O LoopStat O Loop End
Fiulee .. I
Dizplay
[T Promoie goup 1o pansnt rame
Frama Caplioh I
Lt Coptin |
Fiama Halp Takl Ligtbre: Halp Taut
4 +
+ +
+ 1 =+ = -
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name in the Name box.

If you need to modify the name of the segment, type the new segment

If a segment or element occurs morethan oncein a
form it isidentified by its name <ID>. The second and
subsequent occurrences areidentified by <ID>:n,
where“n” isthenumber of the occurrencein the form.

3. If youwant to modify the description of the segment, type a new
description in the Desc box. This box is used to provide a brief
explanation of the segment that allows you to differentiate it from

similar segments.

4. Inthe Min Usage box, type the minimum amount of times the segment

must repeat.

If theMin Usagebox containsa“0” (zero), the segment
is“conditional.” If theMin Usagebox containsa*“1” or

greater, the segment is“ mandatory.”

5. If you want the segment to repeat (loop), type the maximum amount of

timesit can repeat in the Max Usage box.
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6. Unlessyou want to indicate that the segment is the beginning of aloop
(Loop Start) or the end of aloop (Loop End), accept the default of
Normal for the Normal/Loop Start/L oop End options. These options are
defined asfollows:

Normal = Thissegment isin theloop but is not the beginning or
ending segment

Loop Start =  This segment marks the beginning of the loop

LoopEnd = Thissegment marks the end of the loop

If you need to modify the display properties of the
segment, you can do so in the Display section of the
Segment Properties dialog. Please see Chapter 6,
Customizing Screen Entry Translation Objectson
page 205 for more information on modifying display
properties.

7. Click OK to save the changes to the segment.

Modifying
Composite A compositeis adata element that contains two or more component data
Properties

elements or sub-elements. You can modify the composite name and
description, and whether or not it is mandatory.

Complete the following steps to modify the properties of a composite;

1. Click the composite you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Composite Properties dialog is displayed.

Compazite Propertias

Mame |07 N Mandaloy
[ eccrphion | Carcal

2. If you want to change the composite name, type the data element
identification number in the Name box.

If a segment, composite, or element occurs morethan
oncein aform it isidentified by itsname<ID>. The
second and subsequent occurrences areidentified by
<ID>:n, where“n” isthe number of the occurrencein
theform.
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3. Click the Mandatory check box to indicate whether or not this
composite must be present. A checkmark means that the compositeis
mandatory.

4. If you want to change the composite description, type the new
description in the Description box.

5. Click CK to save the changes to the composite.

Modifying
Element Each segment or composite contains a group of logically-related elements.

P rope rties These elements define the structure of the EDI data that your system needs
to process the document.

Complete the following steps to modify the properties of an element:

1. Double-click the element you want to modify to access the Field
Properties dialog.

izl 'opoitics
e [0
b [
ala W aldakion
Mn lax  Tpp= Screen Famnal EDN Foemat —
[ Mendalow [1 |35 [anig  [#] [+

2. Tochangethe name of the element, type the new namein the Name box.
The name is typically the element sequence number.

If a segment or element occursmorethan oncein a
form it isidentified by its name <ID>. The second and
subsequent occurrences areidentified by <ID>:n,
where“n” isthenumber of the occurrencein the form.

3. To changethe description of the element, type the new descriptionin the
Description box. The description is used to provide a brief explanation
of the element that allows you to differentiate it from similar elements.

4. If you want to designate the element as “mandatory” (must be present),
click the Mandatory check box.
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Activating EDI
Form
Components

5. To change the minimum length of the element, type the minimum length
in the Min box. If the data is |ess than the minimum length, a
compliance error is generated when translation occurs.

6. To change the maximum length of the element, type the maximum
length in the Max box.

7. Fromthe Typelist, select the type of the element. Valid values are:

String = aphanumeric element
Number = numeric or real element
Dt/Tm = date or time element

8. From the Screen Format list, select how the data element isformatted on
the form. The choicesfor thisbox depend on the type of the element you
selected from the Type list. If you choose Number or Dt/Tm in the Type
box, you can select the data format from the Format list. If you selected
String from the Type box, you should type a syntax token to denote that
this element must be formatted as the specified syntax token dictates
(the default syntax token is“X"). Please see Using Syntax Tokens on
page 53 for more information on defining and using syntax tokens.

9. Fromthe EDI Format list, select how the data element is formatted in
the EDI file. The choices for this box depend on the type of the element
you selected from the Type list. If you choose Number or Dt/Tmin the
Type box, you can select the data format from the Format list. If you
selected String from the Type box, you should type a syntax token to
denote that this element must be formatted as the specified syntax token
dictates (the default syntax token is“X"). Please see Using Syntax
Tokens on page 53 for more information on defining and using syntax
tokens.

10. Click OK to save the changes to the element.

When Sterling Gentran:Director generates the EDI sides of the form, the
system includes al the groups, segments, composites, and elements that are
defined by the standard agency for the version of the document you selected.
The system activates all the groups, segments, composites, and elementsthat
are defined as “mandatory” (must be present) by the standard. The system
does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

When tranglating data, the system does not process groups, segments,
composites, and elements that are not activated. Therefore, you must activate
the groups, segments, composites, and elements that are not defined as
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mandatory by the standard, but that you have determined that you need to
usein the form.

Complete the following steps to activate groups, segments, composites, and
elements:

1. Click the ACTI VATE button on the Main Toolbar.

2. Open (double-click) each group that contains groups or segments that
need to be activated.

Asan alternative to opening each form component
(steps 2, 5, and 7), you can select Expand All from the
View menu to open every form component. You can
also select a form component and select Expand
Branch from the View menu to open that form
component.

3. Click each inactive group that you need to use to activate it.s.

If you accidentally click a group, segment, composite,

or element that you did not mean to activate, click the
item with the right mouse button to accessthe shortcut
menu. Select Deactivate from the shortcut menu.

4. Click each inactive segment that you need to use to activate it.

Open (double-click) each segment that contains composites or elements
that need to be activated.

Click each inactive composite that you need to use to activate it.

Open (double-click) each composite that contains elements that need to
be activated.

Click each inactive element that you need to useto activateit.

Once you have activated all the necessary groups, segments, and
elements, click the ACTI VATE button on the Main Toolbar to turn
activation mode off.
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Promoting

Grou ps an d  The Promote function extracts one iteration (instance) of agroup or
Repeati ng repeating segment. It also sets the promote flag and places the active

elementsin the parent frame.

Segments
9 You can use the Copy and Paste functions (and change the number in the

maximum usage box) to accomplish the same task. However, Promoteisa
specialized function that guarantees the integrity of your EDI structure.
Depending on the circumstances, you may use the Split or Copy/Cut and
Paste functionsinstead. Please see Splitting Groups and Repeating Segments
on page 32 for more information on splitting groups and repeating segment.
Please see Using Copy, Cut, and Paste on page 33 for more information on
copying, cutting, and pasting.

The Promote function is only availableif a group or
repeating segment is selected.

Complete the following steps to promote a group or repeating segment:

1. Highlight the group or repeating segment from which you want to
extract oneiteration.

2. Click the PROMOTE button on the Main Toolbar. This extracts one
iteration (instance) of the looping structure.

Splitti ng Grou PS The Split function enables you to break a group or repeating segment into
; two loops. You typically use this function when you need more than one
and Re peatl ng instance of the same form component that still occurs multiple times. You
Segments  can also usethe Split function to split oneinstance of agroup without setting
the promote flag (the Split function never sets the promote flag).

You can use the Copy and Paste functions (and change the number in the
maximum usage box) to accomplish the same task. However, Splitisa
specialized function that guarantees the integrity of your EDI structure.

The Split function isonly availableif a group or
repeating segment is selected.

Complete the following steps to split a group or repeating segment:

1. Highlight the group or repeating segment from which you want to
extract oneiteration.
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Using Copy,
Cut, and Paste

2. Click the SPLI T button on the Main Toolbar. The Split dialog is
displayed.

S plit

First Loop Entries IU

Cancel |

3. IntheFirst Loop Entries box, type the number that indicates the
sequential number of iterations where you want the group or repeating
segment split. For example, if the X loop repeats a maximum number of
5 times, and you type “2” in the First Loop Entries box, the resulting
split generates one X loop that repeats a maximum of 2 timesand a
second X loop that repeats a maximum of 3 times.

The number you enter in the First Loop Entries box
must be greater than zero and less than the maximum
number of iterations of the loop.

4. Click OK to exit the Split dialog.

The Copy, Cut, and Paste functions are typically used to move EDI
information in the form. You may need to use these functionsif you are
using an EDI standard differently, or if you need to create nested looping
structures.

You can cut or copy asingle form component (loop, segment, composite,
element, record, or field) and paste it in another location in the form. Copied
form components retain all the information of the original form component.
If the copied form component contains subordinate form components (like a
segment contains subordinate el ements), the subordinate form components
are also copied. You can also cut, copy, and paste a form component from
one form to another.

Complete the following steps to cut, copy, and paste aform component;
1. Select the form component that you want to cut or copy.
2. Click the Copy button on the Main Toolbar.

3. If you are pasting the form component in another form, open that form,
if it isnot already open. Please see Opening a Form on page 38 for more
information on opening aform.
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4.

Select the form component that you want the cut or copied selection
pasted after.

Click the PASTE button on the Main Tool bar to paste the contents of the
Clipboard. If the form component that you selected is a group, Sterling

Gentran:Director prompts you to specify whether you want the contents
of the Clipboard pasted as a child (subordinate) of the group or pasted at
the same level as the group. Select the appropriate option and click OK.

The corkettz af the clipboard can be pasted ae followe:

9 axha 0 pliors

(' Pazte ac a chid af selactad ilam

{1 Pazte alter zekected ibem [ tha zame Evel

Example Inthisexample, you are defining an ANSI X 12 Ship Notice/Manifest (856).
When the system generates the 856 document, it containsone HL group. The
HL group identifies dependencies between and the content of hierarchically-
related groups of segments.

However, for your EDI file, you need to define additional levels of detail
information. The details that you need to define include shipment, order, and
lineitem information. In order to modify the structure of your EDI fileto
accommodate these requirements, you need to use the Copy and Paste
functions to create a nested looping structure for the HL group.

Complete the following steps to create a nested looping structure:

1
2.

May 2011

Highlight the HL group. Click the Copy button on the Main Toolbar.

Select the form component that you want the cut or copied selection to
be pasted after.

Click the PASTE button on the Main Tool bar to paste the contents of the
Clipboard.

If the form component that you selected is a group, Sterling

Gentran:Director prompts you to specify whether you want the contents
of the Clipboard pasted as a child (subordinate) of the group or pasted at
the same level as the group. Select the appropriate option and click OK.

Click the Paste after selected item (at the same level) option and click
OK to paste the Clipboard contents at the same level as the group.
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5. Select Properties from the Edit menu to access the Group Properties
dialog.
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6. Inthe Desc box, type a specialized definition to identify this group as
containing shipment information.

7. Click OK to save the change and exit the Group Properties dialog.

Select the form component in the HL that you want the nested HL group
(order information) pasted after.

9. Click the PASTE button on the Main Toolbar to paste the contents of the
Clipboard. Click the Paste after selected item (at the same level) option
and click OK on the prompt dial og to paste the Clipboard contents at the
same level asthe group. The second HL group is added as a nested loop
to the original HL loop.
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10. Select Properties from the Edit menu to access the Group Properties
dialog for the second HL group.
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11. Inthe Desc box, type a specialized definition to identify this group as

containing order information.

12. Click OK to save the change and exit the Group Properties dia og.

13. Double-click the second HL group (order information) to open it.

14. Select the form component in the HL that you want the nested HL group

(item information) pasted after.

15. Click the PASTE button on the Main Toolbar to paste the contents of the
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Clipboard. Click the Paste after selected item (at the same level) option
and click OK on the prompt dial og to paste the Clipboard contents at the
same level asthe group. Thethird HL group (item information) is added
as anested loop of the second HL group.
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16. Select Properties from the Edit menu to access the Group Properties
dialog for the third HL group.
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17. Inthe Desc box, type a specialized definition to identify this group as
containing line item information.

18. Click OK to save the change and exit the Group Properties dial og.

19. You are now ready to activate the appropriate groups, segments, and
elementsin the new HL nested looping structure. Please see Selecting
Which Form Components to Use on page 67 for more information on
activating.
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Opening a Form

Opening aform loads it into Sterling Gentran:Director and enables you to
view or edit it. The Forms Integration subsystem allows you to have multiple
forms open, but only one form has focus.

Complete the following steps to open aform:
1. Select Open from the File menu to display the Open dialog.

Open 7] x|
Look jn: |El Farmns j ﬁl :

PET_8105.5TF
PET_850P.5TP
PETEINYS.5TP
PETEORDP.STP
PETTINY3.5TP
PETTORDF.STP

Type or select the file
name of the form you
want to open

File name: |

Files of type: IForms[“.stp] j Cancel |

2. The“Look in” list should reflect the drive\folder where Sterling
Gentran:Director isinstalled. The default is GENTRAN
Director\BIN\Forms. If the current folder is not the correct one, select
the appropriate folder.

3. Select thetype of file that you want to display from the Files of Type
list. The default file extension is .STP.

4. Select the map that you want to load into the system from thelist or type
it in the File Name box.

5. Double-click the filename or click OPEN to open the selected form.
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Saving a Form

The Save function writes (saves) the currently selected form to disk. If the
form was saved before and you completed the Translation Object Details
dialog, complete the following step to save the current form:

Select Save from the File menu or the Main Toolbar. The system saves
the current form under the same name that it was previoudly saved.

If you have performed any functionsthat invalidatethe
current format of the trandation object, the Save
function isnot available until you regeneratethe
layout.

If it isanew form that you have not saved before, complete the following

steps:
1. Select Savefrom the File menuto display the Trandation Object Details
dialog.

Tranalalivn Mlgeed Melails

rSummey
A kher Diezcliption Traredation Object Function Spetem
Scieen ent 2| C
I I e |—I | Cancel I
~emon Conbrot

Major walgion IEI Minar verzion IEI Eu:urrpiladunl

EDI Associaliohs

Irput Output

hgenep IE_ [ Ecitact IE_ [ Edilaci

Weson  [098001 | | EDIFACT 1982 REL | [052001 | EDIFACT 1332 REL
Tramsacion  |MWOIC | INWOICE MESSAE | [INWOIC | IMVIICE MESSAG

s [1_ i

F Group I I I I

2. Complete the Author box. This box typically contains the name of the
person who created the form.

3. Complete the Description box. This box must be unique becauseit is
used by the system to identify the form. We recommend that you use the
following identifying characteristics: the partner that thisformis used
for, the standard, the version, the type of transaction this form uses, and
the type of form. For example, “MWT X 3030 850 Print” isthe
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description of aprint translation object used to print documents for
partner MWT, for an ANSI X.12 version 003030 Purchase Order (850).

Verify the type of trandlation object in the Trandlation Object Function
list.

Complete the Mgjor and Minor boxesif you want to designate aversion
number for thistranslation object. Type the version number in the Major
box and the release number in the Minor box.

The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain the EDI format. You can change the information
in these boxes, but it will not alter the content of the form. You may
wish to alter these boxesif, for example, you want the form to reflect a
standards version that is not loaded on your system. You can change the
version on this dialog, and then ater the form to be compliant with that
version.

Click OK to save the translation object details and access the Save As
dialog.

GSave As HE

Save jr: Ia Forms ﬂ gl I__-_

File name:  [INVOIC.STP

Save az type: |Forms [*.2tp] j Cancel |

Type the name of the form (one to eight characters) in the “File name”
box, or accept the default that the system prompts for you. The default
file extensionis .STP.

Click SAVE to save the form.
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Naming a Form

You allocate afilename to aform when you save the form for the first time
or use the Save As function to save a copy of the form under a different
name. The name of the form must be one to eight unique characters that
define the form in a meaningful way. For example, “850 MWT.STP” isthe
name of aform for an ANSI Purchase Order (850) for partner MWT.

The naming conventions in Sterling Gentran:Director are as follows:

» The source form (form created in Sterling Gentran:Director) should be
named using the file extension .STP (i.e., MWT_850.STP)

e The compiled translation object (translation object that is the result of
compiling the source form) should be named using the same filename
that was allocated to the source form BUT with the file extension .TPL
(i.e, MWT_850.TPL)

We recommend that you use these naming convention to distinguish source
forms and compiled translation objects from other types of files. We also
recommend that you use the same filename (different file extension) for a
source form and the translation object that was compiled from it.

Be very careful not to overlay the source form with the
compiled translation object. Usethe . TPL fileextension
to distinguish the translation object.

Complete the following steps to save a copy of the current form under a
different name;

1. Select Save As... from the File menu to display the Save As dialog.

2. Typethe name of the form (oneto eight characters) in the “File name”
box, or accept the default that the system prompts for you (using the
default .STP file extension). Click SAVE to save the form copy under
the new name and exit the Save As dialog.
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Compiling a Translation Object

The Compile function compiles the form and creates a trandl ation object.
The form that you create using Sterling Gentran:Director is a source form.
When that source form is compiled, the result is a compiled translation
object.

Thistranglation object must be registered with the Sterling Gentran: Director
system before you can useit. You use the Compile function after theformis
completed and saved. Please see Saving a Form on page 39 for more
information on saving aform.

Complete the following steps to compile aform and generate atrandlation
object:

1. Select Compile from the File menu or the Main Toolbar to display the
Run-Time Trandation Object Name dial og.

Run-Time Translation Object Hame EHE

Save i IaTransDbi j gl IE_;

File: name: IPET_EDHD.TF‘L

Save az type: ITransIatic-n Objects [~ TPL) ﬂ Cancel |

2. The system defaults the name of the translation object (.TPL file) with
the same filename (one to eight characters long) as you named the form
(.STPfile). Preserving the samefilename (with different file extensions)
means that the relationship between the source form and the compiled
tranglation object will remain evident. For example, if the source form
nameis MWT_850.STP, the compiled translation object nameis
MWT_850.TPL.

Bevery careful not to overlay the source form with the
compiled translation object. Usethe . TPL fileextension

to distinguish thetranslation object.
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From the “Savein” list, change the drive\folder where the compiled
translation object is stored, if necessary.

Do NOT storethe compiled translation object in the
GENTRAN Director\RegTransObj folder. Thisfolder
isreserved for storing a copy of each translation object
you register with Sterling Gentran:Director.

Click SAVE and the system compiles the form and creates a trandlation
object. The Compile Errors diaog is displayed to indicate any errors or
warnings. Click OK to exit this dialog. If any errors occurred, correct
the problems and recompile the trandlation object. The date that the
transl ation object was compiled on is automatically loaded into the
Compiled on box on the Translation Object Details dialog.
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5.

6.
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Select Save from the File menu to save the source form with the
Compiled on date.

Thistrandation object must be registered with the Sterling
Gentran:Director system before you can use it. See the IBM® Serling

Gentran: Director® Forms Integration User Guide for information on
registering a trandation object.

May 2011 43



Printing a Report

Form Integration Basics

Printing a Report

The Print function enables you to print a report for the current form.

You can print areport to afile by selecting Print to
File... from the File menu. Change the defaults on the

Print Optionsdialog and click OK to display the Print
to Filedialog. Typethe name of thefile to which you
want thereport printed and click OK.

Complete the following steps to print a report.

1
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Select Print from the File menu or the Main Toolbar to access the Print
Options diaog.

Select the reports that you want by clicking the appropriate check boxes
in the Report section. Click OK and the Print dialog is displayed.

Set the appropriate options. Click OK if you do not need to change
Setup options, and the report is printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialog is displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog. Click OK on the Print dialog and the
report is printed.

Click OPTI ONS... if you need to access printer setup options
information. The Options dialog is displayed.

Set the appropriate options. Click OK to return to the Print Setup dialog.
Click OK on the Print Setup dialog to return to the Print dialog. Click
OK on the Print dialog and the report is printed.
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Formatting Your Data

When you define or modify aelement, you must specify the type and format.
The options that are available for the format of the element depend on which
type you select (string, number, or Dt/Tm).

Using the String

Type A string type element contains one or more printable characters. If you
specify that an element is a string type, you must designate the format by
specifying a syntax token.

Syntax tokens enable you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type
element. You can then use the syntax tokensin the Format box of the Field
Properties dialog. This enables you to define what type of characters should
be used while compliance checking each element (i.e., alphanumeric within
a certain range, numeric within a certain range, etc.).

Creating a Syntax Complete the following steps to create a syntax token:

Token (Western When you set up a token, it appliesonly to that form.
European You may need to set one up for each form that you

languages) create.

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.

Syntax Tokens 1]

Token  Allowed character ranges

A AZaz
M 09, --++

Click New... bt A7 3209, ++ [[)) A5 EE &&’“‘,( New. D
Change. .. |

Delete |
4| I _,I [E{ES . |

The Token column contains the value designated as the syntax token for
each existing syntax token. The Token contains arange of characters
that, when applied to an element, dictate the way that element must be
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2.

Type a one-
character token

3.

formatted. If the element is not formatted as specified, the system
generates a compliance error.

The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of
apair of charactersthat define the start and end characters.

The DBCS... button isonly availableif you are
executing a double-byte version of Windows NT.

Click NEW.. to access the Edit Syntax Token dialog.

Edit Sprtax [okon E
el )
~Charachar Rangee———
Starl End —
P o ——" Click New...
—

In the Token box, type the unique one-character al phanumeric value that
the system recognizes as containing the allowed range of charactersyou
designate.

The Token can only be one unique character, upper- or
lower-case alphabetic or numeric“1” -“9",

May 2011

The Character Ranges list contains the character range or ranges that
you define for this token. You can define more than one character range
for each token. For example, you can define the token “A” as alowing
the character range “A” through “Z” and the character range “a’
through “z”. Thisindicates that token “A” only allows upper-case and
lower-case alphabetics.
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4. Click the NEW.. button on the Edit Syntax Tokens dialog. The Edit
Character Range dialog is displayed, which enables you to create a
character range.

Edit Character Range

Start character (\ |

End character Cancel |
Serling Gentran:Director usesthe ANSI Character
Set when determining the start-end range.
For Western European languages, consult the ANSI
character chart (1252 Windows L atin 1). Thischart
also displays ranges so that you can enter appropriate
rangesfor the charactersin your language. If no chart
isavailable, use the following guidelines:

n Toinclude all the accented charactersin the major
languages of Western Europe, add the following

Click OK

Type the range of
characters

ranges.

Start End
0xCO 0xD6
0xD8 0xF6
OxF8 OxFC

n Scandinavian usersshould also add thefollowingin

order toinclude (E and ce

Start End
0x8C 0x8C
0x9C 0x9C

5. Inthe Start character box, type the character that begins the allowed
token range. For example, if the character range you want to defineis
“B” through “D,” type“B” in the Start character box. If you type a
character, such as é, that is not accepted, you need to enter it in hex
code. To enter hex characters, “0(zero)x” or “0X,” followed by the hex
code. For example, the hex equivalent of éis OXE9.

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 47



Formatting Your Data

Form Integration Basics

Creating a Syntax
Token (Far Eastern
languages)

Click DCBS
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The Start character and End character can only be one
(2) character, upper- or lower-case alphabetic or
numeric“1” -“9.”

6. Inthe End Character box, type the character that terminates the allowed
token range. Use the guidelines from step 5.

7. Click OK'to return to the Edit Syntax Tokens dialog.

8. Toadd additional character ranges to the syntax token, repeat steps4 - 7
as many times as necessary.

9. Click OKto save the syntax token and return to the Syntax Tokens
dialog.

10. Click CLOSE to exit the Syntax Tokens dialog.

The DBCS syntax token function enables you to create aform that accepts
double-byte characters. If you are running Sterling Gentran:Director on a
Chinese, Japanese, or Korean version of Windows NT, the DBCS button on
the Syntax Tokens dialog is available.

DBCS tokens are displayed only in the DBCS Syntax Tokens dialog, not in
thelist in the Syntax Tokens dial og.

Complete the following steps to create a DBCS syntax token:

When you set up a DBCStoken, it applies only to that
form. You may need to set one up for each form that
you create.

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.

Syntax Tokens 1]
Token  Allowed character ranges
B AZaz
M 09, -++
# AZaz0, 4+ [[1]: AN e
Mew... |
Change. .. |
Delete |
il | N DBES. |
H i H )
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2. Click DCBS to access the DCBS Syntax Token dialog.

Ples... Click New

Lead-Eyte oo - Zancel |
Trail-Bytes

0007 {02 {03 {04{05[0a 030904 (0B |0C0D(0F | 0F |
i (AN AN AR AN BN | R/ /0 N0 00
o nnnnnn AN EE AN BE RN BN BE B
yall NI AN - !
aolof1{213(4l5lal?(al9 [ 1<{=]>[¥%
A @ | A[BICIDIETFIGIHIT[JIKILIMINIG
B0 P RISITIUN (WIKIYIZILIEIT]"
ol “lalblcldlel[flalhlililk{l|m|n|ol]
W0 plalr[s{tlulw w vy lz (LTI 0]
g0 N AN AIninn [ AN BN ENEN RN RN BN R
oo RN nn(nnin AN BN AN BE RN ER BE B
i | Tl NI AN FA N ERY
BO| - [FlA (P [T|A1A[=(2 (T[] A[E[Y
col A (F W (b {2 [®[JIN[E]TIATR]Y
DOl |AlA P22 [ULLIO[ P[]
AN BN BN AN BN AN AN R/ /0 N0 00
FOI RN Hninnin AN RN RN EE RN AR BE B

Double-byte characters are composed of alead byte
and atrail byte. In the above example, the character A
iscode point 0041.

4. Inthe Token box, type the unique one-character al phanumeric value that
the system recognizes as containing the allowed range of charactersyou
designate.
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Do you want to include all charactersin the Trail-Bytes section of the
dialog?

If yes, continue with step 7..
If no, continue with step 6..

Usethe Lead-Bytelist to view other charactersin the code page on your
system. To exclude individual characters or groups of characters from
the token, select them (grey them out).

Click CLOSE to save the syntax token and return to the Syntax Tokens
dialog.

Click CLOSE to exit the Syntax Tokens dial og.

Editing a Syntax Complete the following steps to edit a syntax token:

Select a syntax

token

Token

May 2011

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens

dialog.
Syntax Tokens E3
Token  Allowed character ranges
I AFaz | Cloze I
b 09 -t
s A azlle 4+ (]|
( i il e
( Change... | )
Dielete
4| | _,I [DHESL. |
Click Change...

The Token column contains the value designated as the syntax token,
for each existing syntax token. The Token contains arange of characters
that, when applied to an element, dictate the way that element must be
formatted. If the element is not formatted as specified, the system
generates a compliance error.

The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of
apair of charactersthat define the start and end characters.
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2. Select asyntax token and click CHANGE... to access the Edit Syntax
Token dialog.

Edit Syntax Token |

Taken IX_ ok |

— Character Ranges el |
Start End

Select the range R 2 ) - LI

you want to 0 9

edit i
+ + ;I Delete |

L Click
Change...

3. If you want to change the token value, type the unique one-character
aphanumeric value that the system recognizes as containing the
allowed range of characters you designate in the Token box.

4. Select the character range you want to modify and click CHANGE... on
the Edit Syntax Tokens dialog. The Edit Character Range dialog is
displayed.

Edit Character Range

Start character |D

End character IS Cancel |

5. Inthe Start character box, type the character that begins the allowed
token range.

The Sart character and End character can only be one
(1) character, upper- or lower-case alphabetic or

numeric“1” -“9.”

6. Inthe End Character box, type the character that terminates the allowed
token range.

7. Click OK'to return to the Edit Syntax Tokens dialog.

To edit additional character ranges for this syntax token, repeat steps 4 -
7 as many times as necessary.

9. Click OK to save the syntax token and return to the Syntax Tokens
dialog.

10. Click CLOSE to exit the Syntax Tokens dialog.
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Deleting a Syntax You can delete asyntax token from the system. You can also delete a specific
Token character range from a syntax token.

Complete the following steps to delete a syntax token:
1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.

Syntax Tokens E
Token  Allowed character ranges

Select the token |ﬂ ﬁ‘ZT_‘_af“
you want to

|
delete O e LTSRS New. |

( Delete | —— Click Delete
‘| | | __DEES. |

2. Highlight the token that you want to delete and click DELETE.
The selected entry isdeleted without further warning.

Complete the following steps to delete a character range from a syntax

token:

1. Select Syntax Tokens from the Edit menu to display the Syntax Tokens
dialog.
Syntax Tokens

Token  Allowed character ranges

B, AZaz | Cloze I

Select a syntax
token

Delete

ﬂ WEESE |

Z New. |
( Change... | — Click Change...
__ Dok |
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2. Select asyntax token and click CHANGE... to access the Edit Syntax
Token dialog.

Edit Syntax Token |

Token IK_ Ok |

— Character Hanges

Start End
Select the character i‘ z - Mewt... |
range you want 0 q
to delete

- - /‘
* = Delete | L Click Delete

3. Highlight the character range that you want to delete and click DELETE.

The selected entry isdeleted without further warning.

Using Syntax You can use syntax tokens in the Format box of the Field Properties dialog.
Tokens Thisenables you to designate a“token” that defines ranges of characters
and/or numbersthat are allowed to be used for a string-type element. The use
of asyntax token enables you to define what characters should be used while
compliance checking this element (i.e., alphanumeric within a certain range,
numeric within a certain range, etc.).

Complete the following steps to use syntax tokens:
4. Double-click an existing element. The Field Propertiesdialog is

displayed.
s [
Descriphion IEIESEF:IF'TIEIH
ala*iaidation
hin Max  Tpp= Formnat —
[ Mendaioy [1 [a0  [Svig  [#] [ szt e

5. From the Type list, select String. This indicates that the element
contains characters.
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6. Inthe Format box, type an existing syntax token to denote that this
element must be formatted as the specified syntax token dictates. Please
see Creating a Syntax Token (Western European languages) on page 45
for more information on creating syntax tokens.

7. Click OK to exit the Field Properties dialog.

Using the

Number Type A number type element contains either an implied decimal or real number
that can be mathematically manipulated. If you specify that an elementisa
number type, you must designate the format by specifying aformat of either
“N” (implied decimal) or “R” (real) and the number of decimal places.

An“N” formatted number is a number that has an implied decimal point
(e.g., “2.01" isformatted as “201"). An “R” formatted number has an
explicit decimal point (e.g., “2.01" isformatted as“2.01"), and truncates
trailing zeroes. Whether you use the “N” or “R” format depends on the
requirements of your application. Regardless of whether you use the “N” or
“R” format, you must also indicate the number of decimal placesin the
element.

You can specify that Serling Gentran:Director
displays and printsall numeric-format elements using
decimal points (formatted asreal). Thisdefault data
format is used when elementsareread from the
standards database. You specify this option on the
Sandard Formatstab of the Preferencesdialog
(choose Preferences... from the Options menu and click
the Standard Formatstab). Then select the“ Display
and print numerics using decimal points (Rx format)”
check box.

54 May 2011 IBM Sterling Gentran:Director Forms Integration User Guide



Form Integration Basics

Formatting Your Data

Complete the following steps to use the number type:

1. Double-click an existing element. The Field Propertiesdialog is

displayed.
izl 'opoitics
Name |1
[ escription ITIIIT;iL INVOICE &bd OUMT
ala* aidetion Bdvanced
kv Max  Tppe Format —
W Mandalop |1 |1IZ| INIJITIhEI EI Ihl2 H Gz,

2. From the Type list, select Number. Thisindicates that the element isa
numeric or real number that can be mathematically manipulated.

3. From the Screen Format list, select the format for the number.

Number formats beginning with “R” represent numbers with an
explicit decimal point. For example, if the format you select is R2,
then numbers is formatted with two places to the right of the
decimal point (e.g., “2.01").

Number formats beginning with “N” represent numbers with an
implied decimal point. The decimal point is not displayed, but the
system still processes the number correctly. For example, if the
format you select is N2, then numbersis formatted with two places
to the right of an implied decimal point.

Valid number formats are the following:

RO

R1

R2

R3

R4

RS

R6

Number formatted with an explicit decimal point and no
decimal places

Number formatted with an explicit decimal point up to 1
decimal place

Number formatted with an explicit decimal point up to 2
decimal places

Number formatted with an explicit decimal point up to 3
decimal places

Number formatted with an explicit decimal point up to 4
decimal places

Number formatted with an explicit decimal point up to 5
decimal places

Number formatted with an explicit decimal point up to 6
decimal places
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R7 Number formatted with an explicit decimal point up to 7
decimal places

R8 Number formatted with an explicit decimal point up to 8
decimal places

R9 Number formatted with an explicit decimal point up to 9
decimal places

NO Number formatted with an implicit decimal point and no
decimal places

N1 Number formatted with an implicit decimal point up to 1
decimal place

N2 Number formatted with an implicit decimal point up to 2
decimal places

N3 Number formatted with an implicit decimal point upto 3
decimal places

N4 Number formatted with an implicit decimal point upto 4
decimal places

N5 Number formatted with an implicit decimal point upto 5
decimal places

N6 Number formatted with an implicit decimal point up to 6
decimal places

N7 Number formatted with an implicit decimal point up to 7
decimal places

N8 Number formatted with an implicit decimal point upto 8
decimal places

N9 Number formatted with an implicit decimal point upto 9
decimal places

If you select an implicit decimal (" N" format) for a
field and the datain that field haslessthan the
specified number of decimal places, thetrandator pads
the data with zeroesto theleft so that it still interprets
the data within the specified format. For example, if
you specify aformat of " N3" for afield, and thedatain

that field is" 1", the trandator interpretsthe data as
".001".

Usually, the number formatsin the Screen Format box
and in the EDI Format box are the same. However, if
thereisan “N” format selected in the EDI Format box,
you might want to select an “R” format in the Screen

Format box so that the decimal point in thenumbersis
displayed.
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4. Verify that the number format selected in the EDI Format list isthe
correct format that iswritten to the EDI file.

A number format must be designated for number-type

elementsin the EDI Format box, even for hidden
fields.

5. Click OKto exit the Field Properties dialog.

Using the

Dt/Tm Type A DtTmtype element contains adate or time. If you specify that an element
isa Dt/Tm type, you must specify exactly how the date or time must be
formatted.

Complete the following steps to use the Dt/Tm type:
1. Double-click an existing element. The Field Propertiesdialog is

displayed.
| izld |'voprabics
N
D eecriplion IIWIIIII:E OATE
alaValdgtion
Win lay  Tpp= Format —
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2. If the screen format for the date or time is longer than the length in the
Max box, type a new maximum field length in the Max box. Thisvalue
should be the maximum number of digits, including separators, that you
expect for the date or time.

Thevaluein the Max box should be the same asthe
valuein the Display L ength box on the Display
Properties dialog (click DI SPLAY... on the Field
Properties dialog to accessthe Display Properties

dialog).

3. Verify that Dt/Tm is selected in the Type list, indicating that the field
value must be a date or atime.
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4. Fromthe Screen Format list, select the format for how you want the date
or time to be formatted in the screen entry translation object.

May 2011

Valid Dt/Tm formats are the following:

MM/DD/YY

YYYYMMDD

YYYY/MM/DD

DD/MM/IYYYY

MM/DD/YYYY

HHMM

HHMMSS

HH:MM

HH:MM:SS

DDMMYY

MMDDYY

DDMMYYYY

MMDDYYYY

YYDDD

DDDYY

YYYYDDD

DDDYYYY

YY/DDD

DDD/YY

Two-digit month, separator, two-digit day, separator,
last two digits of year (example: 12/15/97 for
December 15, 1997)

Four-digit year, two-digit month, two-digit day
(example: 19971215)

Four-digit year, separator, two-digit month, separator,
two-digit day (example: 1997/12/15)

Two-digit day, separator, two-digit month, separator,
four-digit year (example: 15/12/1997)

Two-digit month, separator, two-digit day, separator,
four-digit year (example: 12/15/1997)

Two-digit hour, two-digit minutes (example: 0330 for
thirty minutes past three o'clock)

Two-digit hour, two-digit minutes, two-digits seconds
(example: 033045 for thirty minutes and forty-five
seconds past three o' clock)

Two-digit hour, separator, two-digit minutes
(example: 03:30)

Two-digit hour, separator, two-digit minutes,
separator, two-digit seconds (example: 03:30:45)
Two-digit day, two-digit month, last two-digits of year
(example: 151297)

Two-digit month, two-digit day, last two-digits of year
(example: 121597)

Two-digit day, two-digit month, four-digit year
(example: 15121997)

Two-digit month, two-digit day, four-digit year
(example: 12151997)

Last two-digits of year, three-digit Julian day
(example: 97349 for the 349th day of 1997)
Three-digit Julian day, last two digits of year
(example: 34997)

Four-digit year, three-digit Julian day (example:
1997349)

Three-digit Julian day, four-digit year (example:
3491997)

Last two digits of year, separator, three-digit Julian
day (example: 97/349)

Three-digit Julian day, separator, last two digits of
year (example: 349/97)
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YYYY/DDD Four-digit year, separator, three-digit Julian day
(example: 1997/349)

DDD/YYYY Three-digit Julian date, separator, four-digit year
(example: 349/1997)

MONTH The month (example: December)

DAY The day of the week (example: Friday)

5. Verify that the date or time format selected in the EDI Format list is the
correct format that iswritten to the EDI file.

A Dt/Tm format must be designated for Dt/Tm-type

elementsin the EDI Format box, even for hidden
fields.

6. Click OK to exit the Field Properties dialog.
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Customizing Your Display

Customizing

The Forms Integration subsystem allows you to customize the display of
formsin several different ways:

e Customizing global display options

e Customizing colours (global option)

*  Customizing fonts (global option)

e Customizing display of EDI File Format and Layout Windows
The form display options can be set or changed at any time.

Global Display Complete the following steps to customize global (for &l forms) display

60

Options

options:

1. Select Preferences... from the Options menu to display the Preferences
diaog (the Treetab is displayed by default). The Preferencesdialogisa
property sheet that enables you to set global defaults for Sterling
Gentran:Director.

Preferences E

Tree |Standald Formatsl Filez I La_l,loutl Confirmationsl

Theze zettings customize the look of the file format tree.

¥ Show group descriptions Colours. .. |
¥ Show record descriptions Fari... |

¥ Show field descriptions
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2. Toturn on the default display of group, record (segment), and field
(element) descriptions, click the check box in front of each in the List
section of the dialog (so acheckmark is displayed in the check box). To
turn off the default display of group, record (segment), and field
(element) descriptions, click the appropriate check box again to clear
the box.

Typically, you want to have all the descriptions displayed for reference.
However, for avariety of reasons, you may not want the descriptions
displayed. Depending on the size of your monitor, it may be easier to
see the entire form if the descriptions are not displayed.

You may want to experiment with shrinking the size of
thefont for the form (see Customizing Global Fonts on
page 63) beforeyou turn off the display of descriptions.

3. Click OK to save changes and exit the Preferences dialog.

Customizing

Global Colours The Colours feature enables you to select foreground and background
coloursto visually define the various form components. The use of colour is
optional.

Complete the following steps to customize colours for all forms:

1. Select Preferences... from the Options menu to display the Preferences
diaog (the Treetab is displayed by default). The Preferencesdialogisa
property sheet that enables you to set global defaults for Sterling
Gentran:Director.
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Click COLOURS... to display the Colours dialog.

eordHSegmer |
Compogite LI Caricel
Attributes

wctive, Conditional
Active, Mandatary
Inactive, Conditional
Inactive, Mandatory

- Sample Text -

Foreground colour

B a-:kirc-und colour

Select the type of form component from the Item list (Group, Record/
Segment, Composite, Field/Element).

Further define the type of form component by choosing whether it is
active or inactive and conditional or mandatory from the Attributes list.
The valid selections are;

» Active, Conditional

* Active, Mandatory

* Inactive, Conditional

* Inactive, Mandatory

Repeat steps 3 and 4 for each combination of Items and Attributes for
which you want to define colours.

Click OK to globally define the selected colours for all forms.
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Customizing

Global Fonts The Font feature enables you to globally change the font that is used in the
display of al forms. The default font that Sterling Gentran:Director usesisa
Sans Serif 9 point. This feature gives you the flexibility to shrink the font if
you need to view more of the form on your monitor, enlarge the font, or
change the type and style to be more easily readable by you.

Complete the following steps to customize the display font for all forms:

1. Select Preferences... from the Options menu to display the Preferences
diaog (the Treetab is displayed by default). The Preferencesdialogisa
property sheet that enables you to set global defaults for Sterling
Gentran:Director.

2. Click FONT... to display the Font dialog.

Font HEd
Font style: Size:
45 5 Serif] IHeguIal 3 (0] I
E Bars o Fogus— pm MEE
MS Seri Italc 10 Lanza |
Raorman Beld 12
Script Bald Italic 14
T Small Fants J 18
Symbol 24
Syztem LI LI LI
— Sample
I AaBbYyLz
Script:
|Western =]

Select the type of font from the Font list. The default is MS Sans Serif.
Select the style from the Font Style list. The default is Regular.
Select the point size from the Size list. The default is 9.

o 0k~ w

You can preview the changes to the font in the Sample box. Click OK to
make the global font changeto all forms.
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Customizing
Display of EDI sterling Gentran:Director enables you to choose how you want the EDI File

File Format and Format and Layout Windows displayed via these three options.

64

Layout *  The Maximize Tree function maximizes the EDI File Format Window.
The Maximize Layout function maximizes the Layout Window.

»  The Rearrange function toggles the display of the EDI File Format
Window and the Layout Window from |eft/right to above/below.

Additionally, Sterling Gentran:Director enables you to customize the
measurement system that the vertical and horizontal rulers use. The default
measurement system isinches, but you can toggle the display to centimeters
by double-clicking the yellow square where the vertical and horizontal rulers
meet.

Windows
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Setting Default Date Format

You typically establish the date format to be used for all date elements one
time only. Thisdefault is used when EDI documents are initially loaded from
the standard. This default can be overridden on the Field Properties dialog.
This global option changes the default date format for all forms. However,
the format of the existing date elements does not change; the default is used
only for new forms.

Complete the following steps to establish the default date format:

1. Select Preferences... from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Sterling Gentran:Director.

2. Click the Standard Formats tab to display the default date formats that
are used when elements are read from the standards database.

Preferences

Tree  Standard Formats | Files I La_l,.loutl Eonfirmationsl

These zettings control the default data formats used when elements are read from the
standards database.

Six-character dates IWMMDD 'I
Eight character dates IMM;"DD;’YY 'I

[~ Always display and print numerics wsing decimal points [Fix format)

U Cancel Help
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3. Select the appropriate six-character and eight-character default date
formats from the Six-character dates and Eight character dates lists.

4. Click OK to accept the default date formats for Six- and Eight-character
date boxes and exit the Preferences dial og.

To change the order in which the date for mats appear
in the Six-character dates and Eight character dates
listsor to add a new date format to thelists, select Date
Formats... from the Options menu.
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Selecting Which Form Components to Use

The form components for an EDI File are the following:

EDI File

Segment

Loop (Group)

Composite Element (EDIFACT and TRADACOMS standards

only)
Element

=T 1=

-

The specific EDI form components that you use depend on the type of form
you are creating, the standard, version, transaction set (document), and
release (TRADACOMS only) selected, and which segments and elements
your company requires. We recommend that you determine which segments
and elements you are using before starting this step.

When Sterling Gentran:Director generates the EDI document, the system
includes al the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. The
system activates al the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements.

When generating the form, the system does not process groups, segments,
composites, and elementsthat are not activated. Therefore, you must activate
the groups, segments, composites, and elements that are not defined as
mandatory by the standard, but that you have determined that you need to
use in the form.

Complete the following steps to activate groups, segments, composites, and
elements:

1. Click the ACTI VATE button on the Main Toolbar.

2. Open (double-click) each group that contains groups or segments that
need to be activated.

Asan alternative to opening each form component
(steps 2, 5, and 7), you can select Expand All from the
View menu to open every form component. You can
also select a form component and select Expand

Branch from the View menu to open that form
component.

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 67



Selecting Which Form Components to Use Form Integration Basics

68

3. Click each inactive group that you need to use to activate it.

May 2011

If you accidentally click a group, segment, composite,
or element that you did not mean to activate, click the
item with theright mouse button to accessthe shortcut
menu. Select Deactivate from the shortcut menu.

Click each inactive segment that you need to use to activateit.

Open (double-click) each segment that contains composites or elements
that need to be activated.

Click each inactive composite that you need to use to activate it.

Open (double-click) each composite that contains elements that need to
be activated.

Click each inactive element that you need to use to activate it. When
you activate an element for a print trand ation object, the word “ Printed”
is displayed before that element’s name. When you activate an element
for a screen entry trandation object, either the words “Edit Box” or
“Drop Down” are displayed before that element’s name. “Edit Box”
indicates that the element isformatted asafield. “Drop Down” indicates
that the element is formatted as a list because you applied a standard
rule that allows a selection of multiple items.

Once you have activated all the necessary groups, segments, and
elements, click the ACTI VATE button on the Main Toolbar to turn
activation mode off.
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Cutting, Copying, and Pasting

You can cut or copy asingle form component (loop, segment, composite, or
element) and paste it in another location in the form. Copied form
components retain all the information of the original form component. If the
copied form component contains subordinate form components (like a
segment contains subordinate el ements), the subordinate form components
are also copied..

You can a'so cut, copy, and paste aform component from one form to

another.

Complete the following steps to cut, copy, and paste aform component;

1. Select the form component that you want to cut or copy.

2. Click the Copy button on the Main Toolbar.

3. If you are pasting the form component in another form, open that form,
if it isnot already open. Please see Opening a Form on page 38 for more
information on opening aform.

4. Select the form component that you want the cut or copied selection
pasted after.

5. Click the PASTE button on the Main Toolbar to paste the contents of the
Clipboard.

If the form component that you selected is a group, Sterling

Gentran:Director prompts you to specify whether you want the contents
of the Clipboard pasted as a child (subordinate) of the group or pasted at
the same level as the group. Select the appropriate option and click OK.

The corkerts af the clipboard can be pested ae followe:

9 axha 0 plione

(W Paste ak a chid af salactad itam

("1 Paste alter 2elected ikem [ e zame el
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Complete the following steps to cut, copy, and paste text from one box to
another or in the extended rules dialogs:

1. Select the text that you want to cut or copy.
2. Click the CUT or COPY button on the Main Toolbar.

3. If you are pasting the text in another form, open that form, if it is not
already open. Please see Opening a Form on page 38 for more
information on opening aform.

4. Position the cursor where you want the cut or copied selection pasted
after.

5. Click the PASTE from the Main Toolbar to paste the contents of the
Clipboard.
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Setting up the Document Name and Reference

The Document Name and Reference makes the identification of a document
created by the form easier in Sterling Gentran:Director. The Document
Name and Reference are two recommended fields that you can specify inthe
Forms Integration subsystem. If you specify either, the corresponding field
in Sterling Gentran:Director document browsers (In Documents, ?In
Documents, Out Documents, ?0ut Documents, Workspace, In Drawer, Out
Drawer, Send Queue, Interchanges) is populated.

Setting up the Document Name is strongly recommended if you want to be
able to differentiate between documents in the document browsersin
Sterling Gentran:Director. If you set up the Document Name in the Forms
Integration subsystem, the Name field of the document browsersthat contain
this document in Sterling Gentran:Director contains the data from that
element. If you set up the Reference in the Forms Integration subsystem, the
RefDatafield of the document browsers that contain this document in
Sterling Gentran:Director contains the data from that element.

You can select any element as the Document Name, but we strongly
recommend that you choose an element that only occurs once in the form.
The element that you select should have adatatype of “string” (datatypeis
specified on the Field Properties dialog). If you need to use an element with
adatatype of Dt/Tm or Numeric for the Document Name or Reference, you

can either:

» Changethe element’s datatypeto “ String” on the Field Properties
dialog.
OR

»  Set up an extended rule to update the document record.

If you change a Dt/Tm or Numeric element's data type
to“Sring,” you lose data type compliance checking for

theoriginal type.
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Complete the following steps to set up the Document Name:

1. Werecommend that you select a non-recurring element from the header
or trailer ssgment. The element that you select varies for each type of
document. The selected element should be something that will help
identify this document meaningfully in Sterling Gentran:Director.

For example:

n For an Invoice this element istypically the Invoice Number.

n For aPurchase Order this element is typically the Purchase Order
Number.

2. Usetheright mouse button to click the element. Select Properties...
from the shortcut menu. The Field Properties dialog is displayed.

Fizld Fropoiticz

[
Descrbion —[IMVEICE NUMEER
ala W aldation
Min Max  Tpp= Soresn Famn al EDI Format —
 artoy [r 1[5 [ora T2 =

3. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to display the Advanced section.

Click the Use Standard Rule check box.
Click the Update option.

From the Table list, select Document Record.
From the Field list, select Document Name.

© N o g &

Click OK to set up the Document Name.
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Complete the following steps to set up the Reference:

1. Select an element from the first segment of the EDI side of the
document. The element that you select varies for each type of document.
The selected element should be something that will help identify this
document meaningfully in Sterling Gentran:Director.

For example:

n For anInvoicethis element istypically the Purchase Order Number.
n For aPurchase Order this element is typically the Contract Number.

2. Usethe right mouse button to click the element you chose. Select
Properties... from the shortcut menu. The Field Propertiesdialog is

displayed.

Field Properties E
Mame |0324
Desciiption  [PURCHASE ORDER NUMEER Cancel |

D ata Walidation Advanced x> |
Min Max  Type Screen Format EDI Farmat =
I Mandator |1— IT IString j IH " Conditions... |
Dizplay... |
3. Click the Use Standard Rule check box.
4. Click the Update option.
5. From the Tablelist, select Document Record.
6. Fromthe Field list, select Reference Data
7. Click OK'to set up the Reference.
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Components

You can customize the properties of each type of form component (segment,
group, element, and composite) on the Properties dialog for that component.

This chapter explains how to customize the properties of form components,
including the following topics:

Customizing the Properties of a Segment or Looping Structure
Using LS and LE Segments

Customizing the Properties of an Element

Customizing the Properties of a Composite Element
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Customizing a Segment or Group

76

You can modify the properties of the segments and groups by changing their
properties on the appropriate Properties dialog, and by using the promote,
split, copy, cut, and paste functions.

Customizing

Grou [p A group contains related segments and/or groups that repeat in sequence
P rop erties until either the group data ends or the maximum number of times that the
loop is allowed to repeat is exhausted. If you create a group that is
subordinate to another group, this corresponds to a nested looping structure
(aloop within aloop).

Complete the following steps to modify the properties of a group:

1. Click the group you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Group Properties dialog is displayed.

laroup Fraportics

Adertficabion
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2. If youwant to modify the group name, type the segment loop
identification code in the Name box.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

3. If you want to modify the group description, type the new description in
the Desc box. Thisbox isused to provide abrief explanation of the loop.

4. Inthe Min Usage box, type the minimum number of times the loop must
be repeated. For a conditional loop, the minimum usage should always
be“0” (zero). For a mandatory loop, the minimum usage should be “1”
or greater.

5. Inthe Max Usage box, type the maximum number of timesthe loop can
be repeated.

6. Click OK to save the changes to the group.

Customizing

Seg ment You can modify the properties of any segment, including the minimum and
P roperti es maximum number of times the segment can repeat, whether the segment is
mandatory or conditional, and whether it isaloop start or loop end segment.
Please see Using Loop Sart and Loop End Segments on page 80 for more
information on using loop start and loop end segments.
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Complete the following steps to modify the properties of a segment:

1. Click the segment you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu to
display the Segment Properties dialog is displayed.

Segquinl Pospealive

rdertfication
Mame |BEG [ Bran [T Us= Key Field
Desc |BE GIMMIKNG SEGMENT FOR FLURCHASE ORDER | Eey Fidd... I
| Promate I
~Laep Contiol
Min Uzage M ak Uzage
I'I |1 ®) Mormal O LoopStat ) Loop End
Fiuleez. .. I
rDimplay
I™ Pamcte goup 1o parent liame
Fiama Caplich I
Lt Coption |
Frama Halp Taxl Liztbow Halp Taat
s +
+ +
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2. If you need to modify the name of the segment, type the segment
identification code in the Name box.

If a segment or element occursmorethan oncein a
form it isidentified by its name <ID>. The second and
subsequent occurrences are identified by <ID>:n,
where“n” isthenumber of the occurrencein the form.

3. If youwant to modify the description of the segment, type a new
description in the Desc box. This box is used to provide a brief
explanation of the segment that allows you to differentiate it from
similar segments.

4. Inthe Min Usage box, type the minimum amount of times the segment
must repeat.

If theMin Usagebox containsa“0” (zero), the segment
is“conditional.” If theMin Usagebox containsa“1” or
greater, the segment is“mandatory.”
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5.

If you want the segment to repeat (Ioop), type the maximum amount of
timesit can repeat in the Max Usage box.

Unless you want to indicate that the segment is the beginning of aloop
(Loop Start) or the end of aloop (Loop End), accept the default of
Normal for the Normal/Loop Start/L oop End options. These options are
defined as follows:

Normal = Thissegment isin theloop but is not the beginning or
ending segment

Loop Start =  This segment marks the beginning of the loop

LoopEnd = Thissegment marks the end of the loop

segment, you can do so in the Display section of the
Segment Properties dialog. Please see Chapter 6,
Customizing Screen Entry Trandlation Objects on
page 205 for more information on modifying display
properties.

Q If you need to modify the display properties of the

7. Click OK to save the changes to the segment.
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Using Loop Start and Loop End Segments

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and L E segments specify the explicit start and end of loops.

Defining a Loop

Start Complete the following steps to define an LS segment for aform:

1. Click the LS segment with the right mouse button to access the shortcut
menu. Select Properties... from the shortcut menu to display the

Segment Properties dialog.
Seymnenl Poupealies
Name [L5 I Biaw [ UseKeyField
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2. Verify that the Loop Start option in the Looping section of the dialog is

selected.

3. Click the Use Key Field check box to specify that the LS segment
matches a sel ected constant.
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4. Click KEY FI ELD... to access the Key Field dialog.

Fiald | EIN
atching nder [ cocal |
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5. Fromthe Fields list, select the Loop Identifier Code. Thislist contains
al the elements that are contained in the segment.

This box gives you the ability to define the Loop Start segment
definition, by specifying that the loop identifier code must have the
value you specify in the Matching Rules section.

6. The Matching Rules section enables you to access all the literal
constants and code lists currently defined for this form.
Click the Use constant option.

7. Click EDI T... (at theright of the Use constant list) to access the
Tranglation Object Constants dialog.

| romslabion Ubyzcl Lonstants

10 Tupe  “ahe
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8.

10.

11

12.
13.

14.
15.
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Click NEW.. to access the Edit Constant dialog.

Edit Lonslant

In the ID box, type the literal constant identifier.

From the Type list, select “ String.” Thisisthe category of thislitera
constant.

In the Value box, type the value of the literal constant.

For ascreen entry form, thisis the loop identifier code that you expect
to receive from your trading partner.

Click OK to add the constant to the system.

Select the constant you created from the list. The system matches the
selected constant against the loop identifier code.

Click OK to exit the Key Field dialog.
Click CLOSE to exit the Segment Properties dial og.
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Defining a Loop
End Complete the following steps to define an LE segment for a form:

1. Click the LE segment with the right mouse button to access the shortcut
menu. Select Properties... from the shortcut menu to display the
Segment Properties dialog.
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2. Verify that the Loop End option in the Looping section of the dialog is
selected.

3. Click the Use Key Field check box to specify that the LE segment
matches a selected constant.

4. Click KEY FI ELD... to access the Key Field dialog.

From the Fieldslist, select the loop identifier code. Thislist contains all
the elements that are contained in the segment. This box gives you the
ability to define the Loop End segment definition, by specifying that the
loop identifier code must have the value you specify in the Matching
Rules section.

6. The Matching Rules section enables you to access al the litera
constants and code lists currently defined for this form. Select the
constant you created for the LS segment from the list. The system
matches the selected constant against the loop identifier code.

7. Click OK to exit the Key Field dialog.
8. Click CLOSE to exit the Segment Properties dialog.
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You can modify the properties of the elements by changing their properties
on the Field Properties dialog, and by defining and modifying element
relational conditions.

Complete the following steps to modify the properties of an element:

1. Double-click the element you want to modify to access the Field
Properties dialog.
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2. To changethe name of the element, type the new namein the Name box.

The name istypically the element sequence number.

Do not use spaces or dashes (-) in the Name box. You
can usethe underscore () to separate words.

May 2011

To change the description of the element, type the new description in the
Description box. The description is used to provide a brief explanation
of the element that allows you to differentiate it from similar elements.

If you want to designate the element as “mandatory” (must be present),
click the Mandatory check box.

To change the minimum number of characters that is acceptable for the
element, type the minimum length in the Min box. If the dataislessthan
the minimum length, a compliance error is generated when tranglation
occurs.

To change the maximum length of the element, type the maximum
length in the Max box.

From the Type list, select the type of the element. Valid values are:

String = aphanumeric element
Number = numericor real e ement
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Defining and
Modifying
Relational

Conditions

Dt/Tm = dateor time element

From the Screen Format list, select how the data element isformatted on
the form. The choicesfor thisbox depend on the type of the element you
selected from the Type list. If you choose Number or Dt/Tm in the Type
box, you can select the data format from the Format list. If you selected
String from the Type box, you should type a syntax token to denote that
this element must be formatted as the specified syntax token dictates
(the default syntax token is“X"). Please see Using Syntax Tokens on
page 53 for more information on defining and using syntax tokens.

From the EDI Format list, select how the data element is formatted in
the EDI file. The choices for this box depend on the type of the element
you selected from the Type list. If you choose Number or Dt/Tm in the
Type box, you can select the data format from the Format list. If you
selected String from the Type box, you should type a syntax token to
denote that this element must be formatted as the specified syntax token
dictates (the default syntax token is“X"). Please see Using Syntax
Tokens on page 53 for more information on defining and using syntax
tokens.

10. Click OK to save the changes to the element.

You can use relational conditions to connect elements together for syntax or
compliance reasons. For example, Element A isinvalid unless Element B is
present. Therefore, if you set up acondition that pairs Elements A and B, the
system generats a compliance error if one of those elementsis not present.

You can a'so view the conditional relationships between elements, as
provided by the standard.

The system enables you to edit EDI conditional
relationships, but if you do, you may alter the

compliance checking criteria. Werecommend that you
view EDI conditions ONLY.
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Complete the following steps to define, modify, and view element relational
conditions:

1. Double-click the element to access the Field Properties dialog.
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2. Click CONDI TI ONS... to access the Field Relational Conditions dialog.
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This dialog enables you to view, modify, or define element rel ational
conditions. If you want to simply view an element relational condition,
do so and click OK to exit the dialog. Continue with the following steps
to define or modify conditions.

3. Sdlect the element connection condition from the Condition Code list.
Valid values are:

» Paired/Multiple—if any of the specified elements are present then
al elements must be present
* Required —at least one of the specified elements must be present

»  Exclusion —no more than one of the specified elements may be
present
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* Conditional —if the first Condition element is present, the rest of
the elements must also be present

» List Conditional —if the first Condition element is present, at |east
one of the specified elements must also be present

4. Select thefirst element from the Condition Field list. Thisisthe element
on which the conditional relationship hingesif you chose Conditional or
List Conditional from the Condition Code list.

The Condition Field list isonly activeif you chose
either Conditional or List Conditional from the
Condition Codelist.

5. ThePossible Fieldslist containsall the elementsin the trand ation object
that are valid to be used in a condition at this point. Highlight an
element or elementsin the Possible Fields list and click the ADD-->
button to move the elementsto the Fields used by relation list, to include
the elements as a part of the conditional relationship.

To highlight ablock of adjacent items, click thefirst item and then press
the SHIFT key and click the last item. To highlight several items that
are not adjacent to each other, pressthe CTRL key and click the items.

6. TheFields used by relation list contains the elements that you selected
to be apart of the conditional relationship. To remove the elements from
the conditional relationship, highlight an element or elementsin the
Fields used by relation list and click the <--REMOVE button to move the
elements back to the Possible Fields list.

7. Click OK to add the conditional relationship to the element.
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Customizing a Composite Element

88

You can modify the properties of a composite element changing the
properties on the Composite Propertiesdialog. A compositeis adata element
that contains two or more component data elements or sub-elements. You
can modify the composite name and description, and whether or not it is
mandatory.

Composite elementsare only used for EDI forms, for
the EDIFACT, TRADACOMS, and ANSI X12 003030
and later standards only.

Complete the following steps to modify the properties of a composite:

1. Click the composite you want to modify with the right mouse button to
access the shortcut menu. Select Properties... from the shortcut menu.

The Composite Properties dialog is displayed.

Compazita Properties
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2. If youwant to change the composite name, type the data element
identification number in the Name box.

If a segment, composite, or element occurs more than
oncein aform it isidentified by itsname<ID>. The
second and subsequent occurrences are identified by
<ID>:n, where“n” isthe number of the occurrencein
theform.

3. Click the Mandatory check box to indicate whether or not this
composite must be present. A checkmark means that the composite is
mandatory.

4. If you want to change the composite description, type the new
description in the Description box.

5. Click OK to save the changes to the composite.
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Sterling Gentran:Director provides you with standard rules that you can
apply to elements. Standard rules give you access to functions that are

Using Standard Rules

necessary for operationsthat arelessinvolved than extended rules. Extended
rules enable you to use a Sterling Gentran:Director proprietary programming

language to perform virtually any operation you require. Please see

Introducing Extended Rules on page 166 for more information on extended
rules.

Each of the standard rules are mutually exclusive (you can use only oneon a

particular element). This chapter defines the standard rules and provides
examples (where appropriate) of when you may use them. This chapter

includes the following topics:

Using the Select standard rule

Using the Update standard rule

Using the Constant standard rule

Using the Use Accum standard rule

Using the Loop Count standard rule

Using the Use Code standard rule

Using the System Date and Time

Using Literal Constants and Qualifying Relationships
Using Partner-Related Information in Forms
Using Accumulators

Using Code List Tables
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Using the Select Standard Rule

The Select function enables you to select entries from alocation table, cross-
reference table, partner table, or lookup table (all tables created in the
Sterling Gentran:Director Partner Editor). You can then map the elementsin
those tables to one or more elementsin the data. The Select function uses the
value of the current element to perform the selection. The results of the
select can be displayed on the screen or printed on areport.

Complete the following steps to use the Select function:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties dialog is displayed.
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Click Advanced>>

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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4. Verify that the Select option is selected.
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The dialog box element definitions are as follows:

Table Select thetable or table and key that you want to select. Valid vaues are:

Partner by EDI codeindicates that the key is the partner's EDI Code
and enables you to map from one of three fields for this partner (Name,
EDI Code, Alternate Code) from the partner table. You entered these
fields on the Partner Definition dialog of the Partner Editor.

Partner by alternate code indicates that the key is the partner's
Application Code and enables you to map from one of three fields for
this partner (Name, EDI Code, Alternate Code) from the partner table.
You entered these fields on the Partner Definition dialog of the Partner
Editor.

Partner by partner key indicatesthat the key isthe partner's Profile ID
enables you to map from one of three fields for this partner (Name, EDI
Code, Alternate Code) from the partner table. You entered these fields
on the Partner Definition dialog of the Partner Editor.

Partner location by name indicates that the name on the L ocations
dialog (for the current partner) of the Partner Editor is the key and
enables you to map from any field in that table. You entered these fields
on the Location Entry dialog of the Partner Editor.

Partner lookup (activates Sub Tablefield) indicates that the key isthe
partner lookup table name for this partner and enables you to map from
any field in that table. You entered these fields on the Lookup Entry
dialog of the Partner Editor.
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» Partner xref by my item (activates Sub Table field) indicates that the
key isthe your item (value) on the partner cross-reference table for this
partner and enables you to map from any field in that table. You entered
these fields on the CrossRef Entry dialog of the Partner Editor.

» Partner xref by partner item (activates Sub Tablefield) indicates
that the key isthe your partner'sitem (value) on the partner cross-
reference table for this partner and enables you to map from any field in
that table. You entered these fields on the CrossRef Entry dialog of the
Partner Editor.

» Division enablesyou to map from one of three fields (Name, EDI Code,
Alternate Code) for the <Internal System User> (system partner) in that
table. You entered these fields on the Partner Locations dialog of the
Partner Editor.

» Division location by name indicates that the key is the name on the
Locations dialog of the Partner Editor for the <Internal System User>
and enables you to map from any field in that table. You entered these
fields on the Locations dialog of the Partner Editor.

» Division lookup (activates Sub Table field) indicates that the key is
the partner lookup table name for the <Internal System User> partner
and enables you to map from any field in that table. You entered these
fields on the Lookup Entry dialog of the Partner Editor.

« Division xref by my item (activates Sub Tablefield) indicates that the
key isthe your item (value) on the partner cross-reference table for the
<Internal System User> partner and enables you to map from any field
in that table. You entered these fields on the CrossRef Entry dialog of
the Partner Editor.

» Division xref by partner item (activates Sub Table field) indicates
that the key isthe your partner'sitem (value) on the partner cross-
reference table for the <Internal System User> partner and enables you
to map from any field in that table. You entered these fields on the
CrossRef Entry dialog of the Partner Editor.

»  Document record enables you to map from any of the fields within the
current document record.

» Generic envelope segment enables you to map from any of the fields
within the current envel ope information, regardless of the EDI standard
used. Thisfunctionisnormally not used unlessyou are familiar with the
generic envel ope table structure for a given standard.

* Interchange enables you to map from any of the fields within the
current interchange record.

*  Group enablesyou to map from any of the fields within the current
group record.
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Sub Table

Exclusive

Map From

Map To

Type the sub table name (if appropriate) in this box.

The Sub Table box isactive only if you select Partner
Lookup, Partner xref by my item, Partner xref by
partner item, Division lookup, Division xref by my

item, or Division xref by partner item from the Table/
Key box.

Click the Exclusive check box if you want the system to generate an error if
the Select does not find avalid table entry. The default is blank (do not
generate an error if the Select is not successful).

From thislist, choose the element from the specified table entry from which
you want to map the contents.

Entries appear in the Map From list only after you
select a Table/K ey.

From thislist, choose the el ement to which you want to map the contents of
the Map From box. Each element from the side of the map with which you
are currently working (input or output) is displayed in thislist. A total of
eight fields can be mapped using one Select rule.

Entriesappear intheMap Tolist only after you select a
Table/K ey, and these entries are activated only after

you highlight an entry in the Map From box.
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Using the Update Standard Rule

The Update function enables you to update a specific field in a document
record, envelope segment, interchange, group, current partner, or document,
with the contents of the element.

Please note that thisfunction updatestheinternal
Serling Gentran:Director database tables. We
recommend that you use thisfunction only if you are
sureyou really want to update theinternal database
tables.

Typically, you only use thisfunction if you want to
update the document name and referencein the
document table. Any other use of thisfunction could
have disastrous consequences!

Complete the following steps to use the Update function:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Update option.
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The dialog box element definitions are as follows:

Table/Key Select the table or key from the Table/Key list that the system updates with
the contents of the current element. Valid values are:
»  Document record (use to update the document name and reference)
*  Generic envelope segment (advanced use only)
» Interchange (advanced use only)
*  Group (advanced use only)
*  Current partner (advanced use only)
*  Document (advanced use only)

Field Select the element from the Field list that the system updates with the
contents of the current element. The elementsthat are available in thislist
depend on the Table/K ey selected.

Example

We recommend that you set up a Document Name for each form, to make
the identification of a document created by thisform easier in Sterling
Gentran:Director. This allowsyou to differentiate between documentsin the
document browsers in Sterling Gentran:Director.

To set up a Document Name, you must select an element in the form that
contains data that distinguishes the documents translated by thisform. Then,
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the Name column of the document browsers that contain this document
contains the data from the selected element.

You can choose any element as the Document Name,
but the element must only occur oncein the document
and must have a data type of “Sring.” For a Purchase
Order, the document nameistypically the Purchase

Order Number.
Complete the following steps to set up the Document Name for an ANSI
X12 Purchase Order:
1. Double-click the BEG03 (0324) element to display the Field Properties
dialog.
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Click Advanced>>
2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
Click the Update option.

4. From the Table/Key list, choose “Document record.” Thisindicates that
you are updating the document record in Sterling Gentran:Director.

5. Fromthe Field list, choose “Document Name.” This indicates that you
are updating the Name column in the document browsers with the
contents of this element.
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The Advanced section of the Field Properties dialog should now look
like the following:
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6. Click OK to set up the document name.

IBM Sterling Gentran:Director Forms Integration User GuideMay 2011 97



Using the Constant Standard Rule Using Standard Rules

Using the Constant Standard Rule

The Constant option enables you to access the System Variable function and
the Constant function. The System Variable function enables you to map the
current date or time to the specified element.

The Constant function enables you to move aliteral constant value to the
specified element and indicate a qualifying relationship with another
element.

Usi ng System The System Variable function enables you to set a variable that maps either
Variables the current date or the current time to the selected element. The selected
element must have a data type of “Date/Time.”

Complete the following steps to use a system variable:

1. Double-click an existing element, or create a new element (please see
Using an EDI File Format on page 20 for more information on creating
elements). The Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Constant option. The System Variable option is selected by
default.

The dialog box element definition is as follows:

Variables Select current date or current time from the Variables list to map that
variable to the element.
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Using a
Constant Constants are used in forms to hold information that is needed later in the
formin a conditional statement. Typically, EDI qualifiers are typically
generated from constants (to indicate a qualifying relationship with another
element).

Complete the following steps to use a constant:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Constant option.

Click the second Constant option.
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Constants

Qualifies

Edit...

Example

The dialog box element definitions are as follows:

Select a constant from the Constants list. This constant is mapped to the
current element. If the necessary constant is not present in the Constants list,
you need to create it by using the Tranglation Object Constants dialog, which
you can access by clicking the EDI T... button.

Select an element from the Qualifieslist to indicate that the current element
qualifies the selected element (establish a qualifying relationship between
the two elements). If the Qualifies element is not generated because of alack
of data, the constant is not moved to the current element.

This button enables you to access the Translation Object Constants dialog,
which allows you to create, edit, and delete literal constants.

Literal constants are used by the system as arepository to store information
that isused at alater point in the form. Typically, constants are used in a
form to generate a qualifier. A qualifier is an element that has avalue
expressed as a code that gives a specific meaning to the function of another
element. A qualifying relationship isthe interaction between an element and
its qualifier. The function of the element changes depending on which code
the qualifier contains.

In thisexample, you use aconstant to define aqualifier for a Product/Service
ID.

Complete the following steps to define a qualifying relationship:

1. Double-click the Product/Service ID Qualifier that you want to use to
further define (qualify) the Product/Service ID. The Field Properties
dialog is displayed.

Click the Use Standard Rule check box.
3. Click the Constant option.
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4. Click the second Constant option.
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Click Edit...

5. Click EDI T... to access the Translation Object Constants dialog.
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Click New...
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10.
11.
12.

Click NEW.. to access the Edit Constant dial og.

Edit Lonzlant

Inthe ID box, type the literal constant identifier. Thisistypicaly a
description of the element in which the constant is used. If you need to
refer to the constant in an extended rule, you should use the datafrom
this element.

From the Type list, select String because the Product/Service ID
Qualifier isformatted as a string data type. Thisindicates the category
of the literal constant.

In the Value box, type “Ul” to indicate that the Product/Service ID
element must contain the UPC Code. Thisisthe value of the literal
constant.

Click OK to add the constant to the system.
Click CLOSE to exit the Tranglation Object Constants dialog.

From the Qualifieslist, select Product/Service ID. Thisisthe element
that the Product/Service ID Qualifier qualifies.

element.

The Qualifieslist contains only the other active
elementsin the same segment asthe qualifying
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The Advanced section of the Field Properties dialog should now ook
like the following.
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When you set a constant valuefor a qualifier field, you
know that you never need to overridethe valuein the
field. In thisinstance, you would probably hide the
field, aswell. Please see Hiding Fields on page 221 for
more information on hiding fields.

13. Click CLOSE on the Field Properties dialog and the qualifying
relationship between the two elements is established.

104 May 2011 IBM Sterling Gentran:Director Forms Integration User Guide



Using Standard Rules

Using the Use Accum Standard Rule

Using the Use Accum Standard Rule

The Use Accum function gives you access to a set of numeric variables that
you can manipulate via numeric operations, and then transfer to and from
elements. Thisfunction enablesyou to add, change, or delete calculationsfor
the element, including hash totals (used to accumulate numeric element
values, i.e., quantity, price, etc.). This function also enables you to load the
accumulated total into a control total element, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific
element or generating increasing or sequential segment or line item numbers.

Please see Using Accumulators for more information about defining
accumulators.

Complete the following steps to use the Use Accum function:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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Primary Accumulator

106

New...

Change...

Delete

3. Click the Use Accum option.
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The dialog box element definitions are as follows:

The Primary Accumulator list contains all existing calculations that were
created for this element.

Click thisbutton to access the Edit Accumulator Entry dialog to create anew
calculation for this element. Please see Using Accumulators for more
information on defining accumulatorsin your form.

Highlight a calculation in the Primary Accumulator list and click this button
to access the Edit Accumulator Entry dialog to edit the selected calculation.
Please see Using Accumulators for more information on defining
accumulators in your form.

Highlight a calculation in the Primary Accumulator list and click this button
to delete the selected calculation.

The selected calculation is deleted without war ning.
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Using the Loop Count Standard Rule

The Loop Count function enables you to obtain the value of the current loop
count, if the element is part of aloop. If the loop isa nested loop, you can
track the current loop or the outer loop. For example, if the Y loop is nested
within the X loop, and the Y loop has cycled through 15 iterations and the X
loop has cycled through 3 iterations, you can choose to count either the “ 15”
(Y loop) or the“3" (X loop).

Complete the following steps to use the Loop Count function:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Loop Count option.
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The dialog box element definition is as follows:

Groups Select theloop that you want to obtain the current value of the loop count. If
theloop isanested loop, you can track the current loop or the outer loop. For
example, if the'Y loop is nested within the X loop, and the Y loop has cycled
through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the“15” (Y loop) or the*3” (X loop).
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Using the Use Code Standard Rule

The Use Code function enables you to select an element from a predefined
code table and specify whether or not a compliance error is generated if the
element does not contain one of the valuesin the code table for screen entry
trangl ation objects. The Use Code function enables you to extract and print
the description of a code for print translation objects.

The Forms Integration subsystem enables you to create code tables to be
used with the current form. You can set up code tables in the Forms
Integration subsystem to function like the partner cross-reference and lookup
tables in Sterling Gentran:Director. However, code tables that are set up in
the Forms I ntegration subsystem can be used only for the current form. Code
tables that you create in Sterling Gentran:Director can be used globally for
al forms.

An element with aUse Code rule enables valuesto either be checked against
or selected from the codes in a specified code table. Codes are typically used
to further qualify another element. For example, if the XX element contains
address information, you can further qualify that element by choosing the
code “SU” from the 0222 table. In the 0222 table, the code “ SU” is described
asa“supplier'saddress.” Therefore, by using this code with the XX element,
you are indicating that the XX element is not just address information, but
address information for the supplier.

Please see Using Code List Tables on page 145 for more information on
using code list tables.

Complete the following steps to use the Use Code function:

1. Double-click an existing element, or create a new element (please see
Using an EDI File for more information on creating elements). The
Field Properties diaog is displayed.
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Click Advanced>>
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Use Code option.
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The dialog box element definitions are as follows:

Table Select atablefrom thelist. The Tableslist contains all the code tables. If the
necessary code tableis not listed in thisbox, click EDI T TABLE... to load or
create a code table.

Exclusive Click the Exclusive check box to specify that, for compliance reasons, the
element must contain one of the codes from the specified table (nothing else
isvalid for that element). For example, if the element is defined as
containing only “YES” or “NO,” you can set up an exclusive code table that
containsonly YES and NO. Then if you receivea“MAYBE” in that
element, the system flags it as an error.

Store Field Select an element from this list where you want the description of the code
(that is used) to appear when the selection is made. For example, if the code
is“SU,” it is much more useful to view the description of the code
(“Supplier's Address). If you selected element “XX” from the Store Field
list, the description for the code used is mapped to element “ X X.”

Edit Table... Click this button to access the Edit Code List dialog, which enables you to
create and edit code list tables.
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Example

For this example you need to have alist displayed during data entry, so the

user can select your partner’s customer product code. Therefore, you need to

establish and use a code table with the Product Service ID Qualifier.

Complete the following steps to select from a code list table:

1. Loadthe codelist table from the standard for the Product/Service ID
Qualifier element. Please see Loading a Code List Table from the
Sandard on page 157 for more information on loading a code table.

Please note that the standards provide code list tables
only for elementsthat use them. For example, in the
TD4 segment, the TD401 (Special Handling Code) and
TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

2. Defineacodelist tablefor the Product/Service ID Qualifier element that
only contains the code value “BP” (Buyer’s Part Number). Please see
Defining a Code List on page 146 for more information on defining a
code table.

3. Double-click the element for which you need to validate data against a
code table (Product/Service ID Qualifier). The Field Propertiesdialog is
displayed.
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Click Advanced>>
4. Click the Use Standard Rule check box.

Click the Use Code option.

From the Table list, select the code list table that the datain this element
isvalidated against (0235).
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If you need to specify that, for compliance reasons, the element must
contain one of the codes from the specified table (nothing elseisvalid
for that element), click the Exclusive check box.

For example, if the element is defined as containing only “YES” or
“NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receive a“MAY BE” in that element, the system
flagsit asan error.

Click OK to add this standard rule to the element.
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Using the System Date and Time

Sterling Gentran:Director enables you to update any element (that has a data
type of “Dt/Tm”) with the current system date or time.

Complete the following steps to update a element with the current system

date or time:
1. Double-click the desired element. The Field Propertiesdialog is
displayed.
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Click Advanced>>

Click the Use Standard Rule check box.
Click the Constant option. The Standard Rules section is displayed.

Click the System Variable option if it is not already selected (System
Variableisthe default).

5. Fromthe Variableslist:

e Select “Current Date” if you want the element to be updated with
the current system date.
OR

e Select “Current Time” if you want the element to be updated with
the current system time.
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Using Literal Constants and Qualifying Relationships

Literal constants are used by the system as arepository to store information
that isused later in the form. You create the literal constant and nameit. You
can “hard code” (enter) avalue that isloaded into the element that uses the
constant. Or, you can store information from an element in a constant by
using an extended rule. However, to use a constant (the information that is
stored in it), you need to use a standard rule, as explained bel ow.

Constants are typically used to define qualifying relationships. A qualifying
rel ationship establishes arelationship between an element and itsqualifier. A
qualifier contains a code that further defines the element. Qualifying
relationships are defined using an standard rule, as explained below.

You can perform the following functions with literal constants and
qualifying relationships:

e Defining Literal Constants

e Editing Literal Constants

e Deleting Literal Constants

» Mapping Literal Constants

e Generating Qualifiers
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Defining Literal

Constants Complete the following steps to create a literal constant so you can useit to
store information:

1. Select Constants from the Edit menu or the Main Toolbar. The
Translation Object Constants dialog is displayed.

Iranzlation Ubecl Lonstants
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Click New...

2. Click NEW.. to access the Edit Constant dial og.

Edit Lonslant

3. InthelD box, typetheliteral constant identifier. Thisistypically a
description of the element in which the constant is used. If you need to
refer to the constant in an extended rule, you should use the datafrom

this box.
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Constants Complete the following steps to edit aliteral constant:
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4. From the Typelist, select the category of thisliteral constant.

* Integer (select for numeric constants that are a positive or negative

natural (non-fraction) number or “0” (zero)

» Real (select for numeric constants that are a positive or negative

integer with an explicit decimal point)
»  Sring (select for alphanumeric constants)

5. Inthe Value box, type the actual constant expression. Thisisthe value

of the literal constant.
6. Click OK to add the constant to the system.
7. Click CLOSE to exit the Trang ation Object Constants dialog.

Using Standard Rules

1. Sdect Constants from the Edit menu or the Main Toolbar. The
Trandation Object Constants dialog is displayed.

I ranalatien Lol Lonstants
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Select a constant and click Change...

2. Highlight the constant you want to modify.
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3. Click CHANGE... to access the Edit Constant dialog.
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4. Make the changesto the constant.
5. Click OK to accept the changes.
6. Click CLOSE to exit the Trand ation Object Constants dialog.

Deleting Literal
Constants Complete the following steps to delete aliteral constant:

1. Select Constants from the Edit menu or the Main Toolbar. The
Translation Object Constants dialog is displayed.
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Select a constant and click Delete
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2. Highlight the constant you want to delete.
3. Click DELETE to remove the constant.

The constant is deleted without war ning.

4. Click CLOSE to exit the Transl ation Object Constants dial og.

Using Literal

Constants Complete the following steps to use a constant in which you previously
stored information using an extended rule:

1. Double-click the element in which you want to use the constant. The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
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Click the second Constant option.
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From the Constants list, select the constant that you want to use.

Click OK and the data that was stored in the selected constant is loaded
in the element.

Generating

Qualifiers A qualifier is an element that has a value expressed as a code that gives a
specific meaning to the function of another element. A qualifying
relationship is the interaction between an element and its qualifier. The
function of the element changes depending on which code the qualifier
contains.

Complete the following steps to define qualifying relationships:

1

o & WD

Double-click the element that you want to use to further define (qualify)
another element. The Field Properties dialog is displayed.

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.

Click the second Constant option.

From the Qualifieslist, select the element that this element qualifies.

The Qualifieslist contains only the other active
elementsin the same segment asthe qualifying

element.
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6. Click OK and the qualifying relationship between the two elementsis
established.

When you set a constant valuefor a qualifier field, you
know that you never need to overridethevaluein the
field. In thisinstance, you would probably hide the
field, aswell. Please see Hiding Fields on page 221 for
more information on hiding fields.
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Using Partner-Related Information in Forms

Using
Information
from the
Partner
Definition

The Forms Integration subsystem allows you to use information from the
Sterling Gentran:Director Partner Editor in your forms via standard rules.
You can map information from your partner's profile in the Partner Editor to
a selected element in the form. You can aso map information from the
Internal System Partner. The definition information and location tables that
you define for the internal system partner can be used for all partners. The
information that you can use includes:

»  Partner or Internal System Partner Definition (Name, EDI Code,
Application Code)

e Partner or Internal System Partner Location Table Fields

*  Lookup Table Fields

» Cross-Reference Table Fields

This function enables you to load information from the Partner or Internal
System Partner Definition into a screen entry or print translation object. For
a screen entry trangation object, the system displays alist which alowsyou
to select the entry from the table. For a print translation object, the system
prints the information on the report.

Complete the following steps to load information from the Partner or
Internal System Partner Definition into a screen entry or print translation
object:

1. Double-click the element to which the standard rule is applied. The
Field Properties dialog is displayed.
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Click Advanced>>
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Information
from Location
Tables
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In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key from which the system looks up the
trading partner. Valid selections are:

« Partner by EDI codeindicates that the key is the partner's EDI
Code and enables you to map from one of three fields for this
partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

» Partner by alternate code indicates that the key is the partner's
Application Code and enables you to map from one of three fields
for this partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

e Partner by partner key indicates that the key isthe partner's
Profile ID and enables you to map from one of three fields for this
partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog of the Partner Editor.

» Division enables you to map from one of three fields (Name, EDI
Code, Alternate Code) for the <Internal System User> (system
partner) on the Partner Definition dialog of the Partner Editor.

If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

From the Map From ligt, select thefield (Name, EDI Code, Application
Code) from which you want the contents mapped.

From the Map To list, select the element to which the information from
the Partner Editor is mapped.

Click OK to add the standard rule.

Each Partner Profile and the Internal System Partner Profile can have many
associated location tables. The location table can be used to contain address-
related information about the partner. You can store your partner’s store
addresses, warehouse addresses, or “invoice to” addresses. For a screen
entry tranglation object, the system displays alist which allows you to select
the entry from the table. For a print translation object, the system prints the
information on the report.

To use information from alocation table, you must have created that table
aready in the Partner Editor. See the IBM® Serling Gentran: Director®
Forms Integration User Guide for more information on creating a Partner
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Using
Information
from Lookup
Tables

|ocation table.

Complete the following steps to load information from aLocation Tableinto
ascreen entry or print translation object:

1. Double-click the element to which the standard rule is applied. The
Field Properties dialog is displayed.

In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key that is used to look up the Partner
L ocation entry. You are allowed to map from any box on the Locations
diaog. Valid selections are:

» Partner location by nameindicates that the name on the L ocations
diaog (for the current partner) of the Partner Editor is the key and
enables you to map from any field on that dialog.

» Division location by nameindicatesthat the key isthe name on the
Locations dialog of the Partner Editor for the <Internal System
User> and enables you to map from any field on the Locations
dialog.

5. If you want the system to generate an error if the lookup fails, click the

Exclusive check box.

6. From the Map From list, select the field from which the contents are
mapped. The fields you can select from are: Name, Address 1, Address
2, Address 3, City, State, Zip, Country, Telephone Number, Fax
Number, Contact Name, Primary Reference, Secondary Reference.

7. From the Map To list, select the element to which the information from
the Partner Editor is mapped.

8. Click OK to add the standard rule,

A lookup tableis used to select information related to a value in inbound or
outbound data. Each Partner Profile and the Internal System Partner Profile
can have many lookup tables associated with it. For a screen entry
tranglation object, the system displays alist which allows you to select the
entry from the table. For a print trandation object, the system prints the
information on the report.

To use information from alookup table, you must have created that table
already in the Partner Editor. See the IBM® Serling Gentran: Director®
Forms Integration User Guide for more information on creating Partner
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lookup tables.

Complete the following steps to load information from a Lookup Table into
ascreen entry or print translation object:

1. Double-click the element to which the standard rule is applied. The
Field Properties dialog is displayed.
In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key from which the system performs the
look up of the trading partner. Valid selections are:

» Partner lookup (activates Sub Table box) indicatesthat thekey is
the partner lookup table name for this partner and enables you to
map from any field on the Lookup Entry dialog of the Partner
Editor.

» Division lookup (activates Sub Table box) indicates that the key
is the partner lookup table name for the <Internal System User>
partner and enables you to map from any field on the Lookup Entry
dialog of the Partner Editor.

In the Sub Table box, type the name of the lookup table.

If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

7. From the Map From list, select the field (Item, Description, Text 1,
Text 2, Text 3, Text 4) from which the contents are mapped.

8. Fromthe Map To lit, select the element to which the information from
the Partner Editor is mapped.

9. Click OK to add the standard rule,

Using
Information Cross-reference tables are used to convert your values to your trading

from Cross- partner's values during outbound processing, or your partner's values to your

values during inbound processing. Each Partner Profile and the Internal
Reference System Partner Profile can have many lookup tables associated with it. For a
Tables screenentry tranglation object, the system displaysalist which allowsyou to

select the entry from the table. For a print trandation object, the system

prints the information on the report.

To use information from a cross-reference (XREF) table, you must have
created that table already in the Partner Editor. See the IBM® Serling
Gentran: Director® Forms Integration User Guide for more information on
creating Partner cross-reference tables.
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Complete the following steps to load information from a Cross-Reference
(XREF) Table into a screen entry or print translation object:

1

Double-click the element to which the standard rule is applied. The
Field Properties dialog is displayed.

In the Advanced section, click the Use Standard Rule check box.
Click the Select option. The Standard Rules section is displayed.

From the Table box, select the key from which the system performs the
look up. For Cross-Reference Tables, valid selections are:

e Partner xref by my item indicates that the key isyour item (value)
on the partner cross-reference table for this partner and enablesyou
to map from any field on the CrossRef Entry dialog of the Partner
Editor.

» Partner xref by partner indicates that the key is your partner's
item (value) on the partner cross-reference table for this partner and
enables you to map from any field on the CrossRef Entry dialog of
the Partner Editor.

» Division xref by my item (activates Sub Table box) indicates that
the key isyour item (value) on the partner cross-reference table for
the <Internal System User> partner and enables you to map from
any field on the CrossRef Entry dialog of the Partner Editor.

» Division xref by partner item (activates Sub Table box) indicates
that the key is your partner's item (value) on the partner cross-
reference table for the <Internal System User> partner and enables
you to map from any field on the CrossRef Entry dialog of the
Partner Editor.

In the Sub Table box, type the name of the cross-reference table.

If you want the system to generate an error if the lookup fails, click the
Exclusive check box.

From the Map From list, select the field (My Item, Partner Item,
Description, Text 1, Text 2, Text 3, Text 4) from which the contents are
mapped.

From the Map To list, select the element to which the information from
the Partner Editor is mapped.

Click OK to add the standard rule.
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Counting Line
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The Use Accum function gives you access to a set of numeric variables that
you can manipulate via numeric operations, and then transfer to and from
elements. This function enables you to calculate sums, hash totals, value
totals, counts, and generate HL level and parent codes, and other
mathematical operations.

This section addresses three specific mathematical operations that you can
perform with accumulators by illustrating an example of when you would
use each.

In this example, you want an incremental count of the number of lineitems
for a screen entry trandation object, and you want to use that total valuein
the Number of Line Items Total element.

Compl ete the following steps to count line items and generate a control total
for an ANSI X12 purchase order:

1. Double-click the PO101 element (in the PO1 segment in the PO1 group).
Thisisthe element that you typically use to count the line items. The
Field Properties dialog is displayed.
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Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Use Accum option.

-nbod\'ﬂllbﬂ.:

W Uz Gtandaid Fiue
1 Selec! 0 Updaba ) Constart @8 Use Accum © Laop Count 1 Uza Cade

Frimary Acoumdalor Opi Dp2 Op3 Opd

M

—([ee_])

Click New...

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. Select aPrimary Accumulator from the list. Before any calculations are
performed on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of this
list.

For this example, select primary accumulator “0.”

Thereisonly one set of accumulatorsfor each form.
Thismeansthat accumulator “0,” whether it isused in
the Primary Accumulator or Alternate Accum box is
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the same accumulator with the same contents. | f you
assign calculationsto accumulator “0” at the beginning
of the form and then use accumulator “0” again later
in the form, the content of that accumulator isthe
result of theearlier calculation. Any additional
calculations you assign to that accumulator are
performed on the contentsresulting from an earlier
calculation.

In the Name box, type “Line Item Number.” Thisis adescriptive alias
that enables you to differentiate what the accumulators you create are
used for.

FromtheFirst list, select “Increment primary.” Thisisthefirst operation
that the system performs. This specifies that the system increments the
value in this accumulator by one for each iteration of the PO1 group.

TheFirst box isactive only after you select a Primary
Accumulator.

The valid selections for the First box are defined as follows:

* Increment primary adds“1” (one) to the contents of the Primary
Accumulator (i.e., Primary = Primary + 1).

e Decrement primary subtracts“1” (one) from the contents of the
Primary Accumulator (i.e., Primary = Primary - 1).

e Sumin primary adds the numeric value (takes the positive or
negative sign of the numbers into account) of the field to the
contents of the Primary Accumulator (i.e., Primary = (+/-)Primary
+ (+/-)Element).

e Hash sum in primary adds the absolute value (does not take the
positive or negative sign of the numbers into account) of the
element to the contents of the Primary Accumulator (i.e., Primary +
Element).

* Load primary loads the contents of the element into the Primary
Accumulator (i.e., Primary = Element).

e Useprimary loads the contents of the Primary Accumulator into
the element (i.e., Element = Primary).

* Zeroprimary setsthe value of the Primary Accumulator to zero
(i.e., Primary = 0).

e Multiply with primary multiplies the element with the contents of
the Primary Accumulator, and stores the result in the Primary
Accumulator (i.e., Primary = Primary * Element).
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Divide by primary divides the element with the contents of the
Primary Accumulator, and stores the result in the Primary
Accumulator (i.e., Primary = Element / Primary).

Divide primary by field divides the contents of the Primary
Accumulator with the element, and stores the result in the Primary
Accumulator (i.e., Primary = Primary / Element).

M odulo with primary divides the contents of the element with the
contents of the Primary Accumulator, and stores the remainder of
that operation in the Primary Accumulator (i.e., Primary = Primary
% Element).

Modulo with field divides the contents of the Primary
Accumulator with the contents of the element, and stores the
remainder of that operation in the Primary Accumulator (i.e.,
Primary = Element % Primary).

Negate primary makes the contents of the Primary Accumulator
negative (i.e., Primary = Primary * -1).

Theonly way to subtract the Primary Accumulator
from the element isto “Negate” the Primary
Accumulator and then usethe“Sum in primary”
operation to add the negative Primary Accumulator to
the element.

Move primary to alter nate copies the contents of the Primary
Accumulator to the Alternate Accum. This overwrites the current
contents of the Alternate Accum field (i.e., Alternate = Primary).

Add primary to alter nate adds the contents of the Primary
Accumulator to the contents of the Alternate Accum, and stores the
result in the Primary Accumulator (i.e., Primary = Primary +
Alternate).

Multiply primary by alter nate multiplies the contents of the
Primary Accumulator with the contents of the Alternate Accum,
and stores the result in the Primary Accumulator (i.e., Primary =
Primary * Alternate).

Divide primary by alter nate divides the contents of the Primary
Accumulator with the contents of the Alternate Accum, and stores
the result in the Primary Accumulator (i.e., Primary = Primary /
Alternate).

Modulo primary with alter nate divides the contents of the
Primary Accumulator with the contents of the Alternate Accum,
and stores the remainder of that operation in the Primary
Accumulator (i.e., Primary = Primary % Alternate).
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8. Fromthe Second list, select “Use primary.” Thisisthe second operation

that the system performs, after the First operation is completed. This

specifies that the system loads the current value of the accumulator into

the PO101 (Assigned I dentification) element.

The values for the Second, Third, and Fourth boxes are listed above.

The Second box isactive only after you select a First

operation that does not involve the Alter nate Accum.
The Third box isactive only after you select a Second
operation. The Fourth box is active only after you

select a Third operation.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulaton Bty

Prirriany Aczurrulstoe |u |:| Harna ILirera'nNu‘nt-ar

-Operalions
Frsl I ncrement pimans [#] Hliemate Aocum | |
Seaond [Llze pimay (2]

Thid | 2]
Fourh | 1]

9. Click CK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:

rAvanced

F Uz= Stendard Auke
1 Select O Updste C Conelanl M UszeAcoum O Loop Coont ©1 Ues Coda

Frimary Acourulaor Op1 dpz DOpd Opd
OLine Iem WNumber Ine Uza Mew...

Chahige...

10. Click OK on the Field Properties dialog to add the standard rule to the
P0101 element.

11. Double-click the CTTO01 element (in the CTT segment). Thisisthe
element that typically contains the total number of lineitems. The Field
Properties dialog is displayed.

I izld | 'vopritics
Nowe |35
Descriion — {1UMEE R OF LINE ITEMS
ala Valdation Bdvancad =i
Mh  Max  Tppe Soreen Famnal EDI Foemat —
F Mendslog [1 |6 [Mumbe [2] [ND [2] [no (2]

Click Advanced>>

12. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
13. Click the Use Accum option.

14. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

IBM Sterling Gentran:Director Forms Integration User GuideMay 2011 131



Using Accumulators Using Standard Rules

15. From the Primary Accumulator list, select primary accumulator “0.”
This accumulator currently contains the total number of line items.

16. FromtheFirst list, select “Use primary” to specify that the system loads
the current value of the accumulator into the CTT01 (Number of Line
Items Total) element.

The Edit Accumulator Entry dialog should now look like this:

bdit Aecumulatar Entry E
Pritany Acourilstoe IEI |:I Marra ILine Ibeem Mumbser l i I
O pef alioee Cancsl I

Frsl  [Use pimay [#] siemate Aocum | |
Sezond | [2]
Thid | 12|
Foulh | 1z

17. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:

Advancad

¥ Uze Standard Fule
) Balect () Update 0 Congtant @ Usabocum T Loop Counl 1 Usza Code

Primang Acounmulstoo Op1 Opd dp3d 0Opd
O-Line Hamn M umbe Us= Mew,..

Change...
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18. Click OK on the Field Properties dialog to add the standard rule to the
CTTO1 element.

The CTTO1 element now contains the total number of lineitemsin the
purchase order.

If you are adding this accumulator to a screen entry
translation object, you would typically set the CTT01
field to display-only. Please see Formatting Display-
Only (Non-Editable) Fields on page 220 for more
information on formatting display-only fields.

Calculating

Hash Totals Inthisexample, you want to count the quantity ordered for each lineitem
and load the total quantity in the CTTO02 (Hash Total) element for a screen
entry tranglation object.

Complete the following steps to count the quantity ordered and generate a
hash total for an ANSI X12 purchase order:

1. Double-click the P0102 element (in the PO1 segment in the PO1 group).
Thisisthe element that you typically use to count the line items. The
Field Properties diaog is displayed.

- [
D ezcriplion II]LlrlNTIT"r' OADERED

ala’aldetion
ki Max  Tppe Scresn Famal EDI Frormat

[T Mandalop |1 IE INuthl EI Ihll] H IND E Cordilices. .

Click Advanced>>
2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
Click the Use Accum option.

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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Select a Primary Accumulator from the list. Before any calculations are
performed on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of this
list.

For this example, select primary accumulator “1.”

In the Name box, type “Total Quantity.” Thisis a descriptive alias that
enables you to differentiate what the accumulators you create are used
for.

From the First list, select “ Sum in primary.” The system adds the
numeric value (takes the positive or negative sign of the numbersinto
account) of the element to the contents of the Primary Accumulator for
each iteration of the PO1 group.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulatar Entry Ed

Frimany Accunnulst oo I‘I |:I Mamma ITu:uIaIQuanlil_l.l

I

Cancal I

O pef alices:
Firel IEum in primane H Lllamata Accumn I |ﬂ
Second | El

Third | |ﬂ
Foulh | 1]

8. Click CK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look

like this:

Advarced

Prirmany decunulaton

¥ U1e Standerd Fuds
1 Seledt (1 Updale (1 Constsnt 8 Uze dccom ) Loop Cowt ) Uge Coda

Op1

Op2 Op3 Opd
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Dekte
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3
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9. Click OK on the Field Properties dialog to add the standard rule to the
P0102 element.

10. Double-click the CTTO02 element (in the CTT segment). Thisisthe
element that typically contains the total quantity of the purchase order.
The Field Properties dialog is displayed.

Nerma ||:|34?

Description IHASH TOTAL

Canc=|

bdvanced =3

ala* aidetion

Win dan

Tppe Screen Famal

EDI Format

J
=

[ Mandalop |1 I‘IIZI

INuth| EI IFIEI

BlE

¢

Displap...

]
:
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12.
13.

Click Advanced>>

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW.. to access the Edit Accumulator Entry dialog to create a

new calculation for this element.
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14. From the Primary Accumulator list, select primary accumulator “1.”
This accumulator currently contains the total quantity.

15. Fromthe First list, select “Use primary.” The system loads the current
value of the accumulator into the CTT02 (Hash Total) element.

The Edit Accumulator Entry dialog should now look like this:

Prirnans Aczurrulst oo I‘I |:I Hamma ITu:-IaIQuanIily I ik I

rOperaliore [ Cancat |
Firel |u=a privnany M Allamata Aceurm | |ﬂ
Siemond | 2]
Thid | H|
Foulh | |

16. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:

-MTGIL-EL;

[¥ Uz Standard Fiuda
| Seled T Updale C Conatmnt @ Usze Acoumn O Loop Count T Uss Code

Primary Accumuleto Op1 Op2 DOpd Opd
1-Total Huantkp Uz =y

Charge ..

ke

17. Click OK on the Field Properties dialog to add the standard rule to the
CTTO2 element.

The CTTO02 element now contains the total quantity of the purchase
order.
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Resetting and

Calculating a Inthisexample, you want to multiply the quantity invoiced for each line

Value Total

item by the unit price to obtain the extended price for a screen entry
tranglation object. Then, you want to generate a running total of extended
price and load the final total into the TDS01 (Total Invoice Amount)
element.

Complete the following steps to multiply the quantity invoiced for each line
item by the unit price to obtain the extended price for an ANSI X12 invoice:

1. Double-click the1T102 element (in the IT1 segment in the IT1 group).
Thisisthe element that you typically use to count the quantity invoiced.
The Field Properties dialog is displayed.

Fizld Fropoitice

-
Descriion — [QUANTITY INVOICED
ala W alidakion _(- )
¥ Mandaien f:" f:aa =RE| R | O

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

Select primary accumulator “2.”

In the Name box, type “Extended Price.” Thisisadescriptive alias that
enables you to differentiate what the accumulators you create are used
for.

7. FromtheFirstlist, select “Load primary.” The system |oads the contents
of the element into the Primary Accumulator for each iteration of the
IT1 group.
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The Edit Accumulator Entry dialog should now look like this:

I:dlt Aecumulatar Entry E
Prirnang Acounulstoo IE |:I Marra IEahandBd Prize I {hif I
O per alioee Cancsl I

Firel ILu:uad primany u Lllamata Accumn I m

Ser_'nndl EI
Third | |ﬂ
Foulh | Hi

8. Click CK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
likethis:

-nbod\'lﬂllbﬂ.:

M Usa Stardand Auk
) Select T Update 0 Coretart @ Uss dccum O] Loog Courk O Uae Cods
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2 etended Frice Load
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=
o

9. Click OK on the Field Properties dialog to add the standard rule to the
T102 element.
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10.

Double-click the IT104 element (in the IT1 segment in the IT1 group).
Thisisthe field that contains the unit price for each lineitem. The Field
Properties dialog is displayed.

Heme II:'E-IE
0 eription IUNIT FRICE
ala Valdation —( [ advancad =2

Mn lax  Tpp= Screen Famnal EDN Foemat p—
F Mandalor |1 IE IHumI:lm |£I IHE H IHEI ¥ ilior..

11

12.
13.

14.
15.

Click Advanced>>

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

Select primary accumulator “2.”

From the First list, select “Multiply with primary.” The system
multiplies the value of the IT104 (Unit Price) element with the contents
of the primary accumulator, and stores the result in the primary
accumulator for each iteration of the IT1 group.

The Edit Accumulator Entry dialog should now look like this:

Edit Accumulatar Entry Ed

Piirary Acourubstor |2 [£] Mama IExhandB-:IF'ri:a i

J per alicee Cancel

Frzl

Second I |£I

ik

|h1|_l|i|:l_|.| with prirman EI Bllemate dccurm I |i|

Third | |i|
Foulh | 12|
16. Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now ook
like this:

Adwanced

¥ Uze Standard Fule
") Sakcl ) Updste © Coretant @ Uga Accum O Loop Counk ) Ues Code

Plimaly fecumulabor Opl Op2 Op2 Op}
2-Extendad Frica Muk Maw...
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17. Click OK on the Field Properties dialog to add the standard rule to the
T104 element.

If thereisan extended price element in your EDI file,
you could load the total from the extended price
calculation into that element. To do this, you need to
use an accumulator on that extended price element
that specifies“ Use primary” for accumulator 2.

Complete the following steps to generate a running total of the extended
price:

1. Double-click the IT104 element (in the IT1 segment in the IT1 group).
Thisisthe element that contains the unit price for each lineitem. The
Field Properties diaog is displayed.

| 1zl | 'opoitics

P IEE'IZ

D e=crighion IUNH' FRICE Cance]

ala’ aidetion —
kv Max  Tppe Screen Famal EDI Format
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Displap...

Click Advanced>>
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2. Inthe Advanced section, you already established one accumulator that
isdisplayed in thelist.

Adwanced
[# Uze Standard Fule
) Sakcl O Updste O Coretant @ Uga Accum O Loop Count O U Code
Plimary fecumulabor Opl Op2 Op2d Opd
Z-Extendad Frica Muk — Mak...
Change ..
Click New...

3. Click NEW.. to access the Edit Accumulator Entry dialog to create
another calculation for this element.

Select primary accumulator “3.”
In the Name box, type “Running Total.”

From the First list, select “ Add primary to alternate.” The system adds
the contents of the primary accumulator to the contents of the alternate
accumulator, and stores the result in the primary accumulator for each
iteration of the IT1 group.

TheFirst box isactive only after you select a Primary
Accumulator.

7. Fromthe Alternate Accum list, select “2.” The system adds the value of
accumulator “2" (which contains the extended price for alineitem) to
the value of accumulator “3.” The system stores the sum in accumulator
“3,” which therefore contains a running total of the extended price with
each iteration of the I T1 group.
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The Edit Accumulator Entry dialog should now look like this:

I:dlt Accumulatar Entry E
Prirnany Accurulshor IS |:I Harra IHLI"ﬂiI'g Tatd I i I
O per alioes Cancd I
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8. Click CK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
likethis:

ridvanced

¥ Use Standard Rule
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9. Click OK on the Field Properties dialog to add the standard rule to the
T104 element.
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Complete the following steps to load the running total of the extended price
into the TDS01 (Total Invoice Amount) element:

1. Double-click the TDS01 element (in the TDS segment in the IT1
group). Thisisthe element that contains the unit pricefor each lineitem.
The Field Properties dialog is displayed.

Fitshl Povypeatives Ed
s |
[ escription ITIIIT;iL INVOICE &bd OUMT

ala* aidetion _/.;:Ivnn::d x3

hin kax
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Click Advanced>>
2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
Click the Use Accum option.

4. Click NEW.. to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

Select primary accumulator “3.”

From the First list, select “Use primary.” The system |loads the contents
of the primary accumulator into the TDS01 (Total Invoice Amount)
element.

The Edit Accumulator Entry dialog should now look like this:

bdit Aecumulatar Entry E

Prirnany Acaurulehor |3 H Hara Ileﬂing Tatdl l i I
- peralicee lml
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7. Click CK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:

Adwanced
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8. Click OK on the Field Properties dialog to add the standard rule to the
TDS01 element.

If you are adding thisaccumulator to a screen entry
translation object, you would typically set the TDS01
field to display-only. Please see Formatting Display-
Only (Non-Editable) Fields on page 220 for more
information on formatting display-only fields.
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Using Code List Tables

Code List Tables are used by EDI standards as repositories for lists of codes.
Each EDI standard provides a code list for each element that can be further
defined with a code. Sterling Gentran:Director allows you to load code lists
from the standard. You can either load all the codesin the table, or you can
select only one or more codes from the table. Once you load or create a code
table, you can use a“Use Code” standard rule. For screen entry templates,
you can useit to select an element from alist that contains a predefined code
table. You can also specify whether or not a compliance error is generated if
the element does not contain one of the valuesin the code table. For print
templates, the Use Code function enables you to extract and print the
description of acode and validate the contents of a element against the
valuesin the code table for print templates.

The Code Lists function a so enables you to store a code's description in an
element/field, create a unique code table, use code values from a code table,
and flag whether or not the system will generate an error if avalidation
against the code table fails. You can import and export code lists and copy
and paste code lists between forms.

An element with a Use Code standard rule applied to it allows values to
either be checked against or selected from the codes in a specified code
table. Codes are typically used to further qualify the element. For example,
the Product/Service ID (0234) element contains a product code that you
expect to be the customer's product code. If you receive avalue in that
element that is something other than the customer's product code, you want
the system to generate an error. So, you first use the code table for the
Product/Service ID Qualifier (0235), but specify when you load it that the
code table should only include the code “BP.” In this code table, the code
“BP" is described as a“Buyer’s Part Number.” Then, you make the 0235
code table exclusive for the Product/Service ID Qualifier (0235) element.
Therefore, by using this code with the qualifier for the Product/Service ID
element, you are indicating that the Product/Service ID element must contain
not just a product code, but product code from the customer.
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You can perform the following functions on Code List Tables:
» Defining aCode List

e Modifying aCode List or Code List Entry

» DeletingaCode List or Code List Entry

e Importing aCode List

» Exporting a Code List

e Loading Code Tables from the Standard

» Copying and Pasting Code Lists

e Validating Data Against Code List Tables

» Loading Code Item Descriptions

Defining a
Code List complete the following steps to define a code list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

Table 1D Dezcription

ACE D GUALIEER

I E

Cloge

Mew...

Change...

Delete

Export...

Copy

Pazte

Click New...
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2. Click NEW.. to access the Edit Code List dialog.

Falit Famle 1 il

'Tdhh DL‘Ja:a
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3. IntheTable ID box, type the name of the element for which this code
list table is used.

4. Inthe Description box, type the description of the element for which
this code list tableis used.

5. Click NEW.. to access the Edit Code List Entry dialog.

Edit Codec List Entry

Wabe

D exriplion | | Canc |

In the Value box, type the actual value of the code.

7. Inthe Description box, type a description of the code value. The code
value description is used if you specify an element (in the Store Fields
list on the Field Properties dialog) to which you want the code
description mapped.

8. Click OK to save the code list entry.

9. Repeat steps 5 through 8 to add more code list entries to the code list
table.

10. Click CLOSE to save and exit the Edit Code List dialog.
11. Click CLOSE to exit the Code Lists dialog.
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Modifying a
Code List complete the following steps to modify a code list table or code list entry:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E3 |

[n] D ezcripti
FROC

Cloze

Mew. .

—\| Change..
Delete
|mport....
Export...

Copy

FPazte

A

Select the code list you want to modify Click Change...

2. Highlight the code list that you want to modify.
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3. Click CHANGE... to access the Edit Code List dialog.

Falit Caple Dl
~Table Oelalz
Tzble D |[EZ]5 Diasc |F‘HDDLI|:T.-'SEFI'-'IEE D QUALIFIER DK
Allwed Codes Canced
Code Y ale ['==cnphion
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Load...

At this point, you can add new code list entriesto the table, delete
entries, or modify code list entries. To modify an entry, highlight it and
click CHANGE... to access the Edit Code List Entry dialog.

Edit Codc Lizt Entry

vae  [eP

[ exrripinn IEIIJ'-r'EFI'E PaRT HUMBER Canc= I

Make the necessary changes.
Click OK to save the code list entry.

Repeat steps 2 through 6 to modify other code list entriesin the code list
table.

Click CLOSE to save and exit the Edit Code List dialog.
Click CLOSE to exit the Code Lists diaog.
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Deleting a
Code List or Completethe following steps to delete a code list table:

Code List Entry 1. Select Code Listsfrom the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists |
Tahble IO Dezcription
Mew. .

Change...

Delete

Irpart. ..

Export...

Copy

Fazte

Rk

Select the code list you want to delete Click Delete

2. If youwant to delete a code list, highlight that list.
3. Click DELETE to delete the code list table.

@ The selected table deleted without war ning.
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Complete the following steps to delete a code list entry:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists E3

Table ID D ezcription

Cloze

Change. ..

Delete

Impat. ..

Export...

Copy
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L Select the code list from which you want to Click Change...
delete an entry

2. Highlight the code list from which you want to delete an entry.

IBM Sterling Gentran:Director Forms Integration User GuideMay 2011 151



Using Code List Tables Using Standard Rules

3. Click CHANGE... to access the Edit Code List dialog.

Falit Caple 1 it
~Table Oelaiz
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4. To delete an entry, highlight it and click DELETE to remove the entry.
Delete any other entries you wish.

The selected entry isdeleted without war ning.

5. Click OK to save the code list table.
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Importing a

Code List The Code List Import function enables you to import code lists created for
another map and share code lists with other users of Sterling
Gentran:Director.

Complete the following steps to import a code list table:

1. Sdect Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Table D Dasanphion

Click Import...
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2. Click | MPORT... to access the Open dialog.

Open
Loak in: I £3 Bin

Filz name: I T Open

Filez of tppe: ID:nde Tables [*CDE] j Cancel |

3. Select the location of the code list file. The default location is
Application Integration install folder (the default is
DirectorConnection\Bin).

Thedefault file extension for codelistsis.CDE.

4. Theimported code list will be available for your use. Click CLCSE to
exit the Code Lists dialog.
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Exporting a

Code List TheCodeList Export function enables you to export code lists to file. This
enables you to define acode list for one map and use that code list in another
map. This function also allows you to share code lists with other users of
Sterling Gentran:Director.

Complete the following steps to export a code list table:

1. Sdect Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

Tahble ID Dezcription

ACE 1D OUALIEER

I x|

Cloze

Mew...

Change...

Delste

Export...

Copy

Faste

Select a code list and click Export..
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2. Select acode list and click EXPORT... to access the Save As dialog.

Save As EE

Save i IaBin j gl Ig: =

File name:  [0235.CDE

Save as lppe: |D:n:|e Tablesz [*.CDE] ﬂ Cancel |

3. Thefile name defaults to the table ID with a“.CDE” file extension. If
you want to change the name, type the export file name in the File Name
box. The default location is the DirectorConnection\Bin folder.

Thedefault file extension for codelistsis.CDE.

4. Click SAVE to export the code list and return to the Code Lists dialog.
5. Click CLOSE to exit the Code Lists dialog.
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Loading a Code
List Table from
the Standard

The EDI standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Special Handling Code) and
TD403 (Hazardous Material Class Code) have code tables provided by the
standard.

Complete the following steps to load a code list table from the standard:

1. Double-click the element for which you need to use a code table. The
Field Properties diaog is displayed.

I izld "opeibics
Nams |o=s
De=cription |un|r OR B&S15 FOA MEASUREMEMT CODE
_—
ala™ aldetion Bdvancad =
Win Max  Tppe Screen Famal EDI Format
[ Mendalo [2 |2 [svirg 3] [ E

Click Advanced>>

In the Advanced section, click the Use Standard Rule check box.

Click the Use Code option.

Adrorced

[+ LUza Standard Fuls
) Gelec! O] Updale O Conatent ©) Uee Accum © Loop Count ) Use Cade

e | g

r ExcliEive

Stars Fisd | [2]
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4. Click EDI T TABLE... to access the Edit Code List dialog.

Fualit Camle 1wl

~Tabk Oelals
TablelD [0365 Desc |IT OF BASIS FOA MEASUREMEMT CODE o
Aillawed Codes Cancsl

Coda Walia Dles=nplion

Mewn

D elata

i G

Laad...

The Table ID box contains the name of the element for which this code
list table will be used. The Description box contains the description of
the element for which this code list table will be used.

5. Click LOAD... to access the Load Code List dialog.

Load Code List E

Select Code Souree

Standard | |ﬂ Ligl |

Cancel I

~Sekect Coder:

Codes | n Standard Codes Select=d

m ACTLAL FOUNDS [4)

0z STATUTE MILE

[1K] SECONDS |—

4 SMBLL SPAAY

[11] LIFTS Add &l ->

ns HEAT LOTS

10 GROUP

11 OUTAT #| |_coFame

1 + « ] [+]
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6. You can either select specific codes that you want to load or select the
entirelist of codes:

» To select specific codes only, from the Codes in Standard lit,
highlight each code that you want to be loaded. Click ADD--> to
move it to the Codes Selected list.

+ Toload the entire code list, click ADD ALL--> to select all the
codes and move them to the Codes Selected list.

We recommend that you only add the codes that you
and your trading partnersare ableto create or accept.
Adding all the codesin the code table (using the ADD

ALL--> button) creates a much larger translation
object than if you only use selected codes.

7. Click OKto load the code list.
8. Click CLOSE to exit the Code Lists diaog.
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Copying and

Pasting Code TheCode List Copy and Paste function enables you to copy code lists from
Lists one map to another.

Complete the following steps to copy and paste a code list table:

1. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Code Lists

Table 1D Description

WICE (O GHALEER

Cloze
MHe
Change...

Delete

Export...

Copy

EERER |

Fazte

|
Select a code list and click Copy..

2. Select acodelist and click COPY... to copy the code list to the clipboard.
3. Click CLOSE to exit the Code Lists dialog.

4. Open the map in which you want to use the code list, if the map is not
already open.
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5. Select Code Lists from the Edit menu or the Main Toolbar. The Code
Listsdialog is displayed.

Tahle D Daschphion

Click Paste..

6. Click PASTE... to add the copied code list to this map.
7. Click CLOSE to exit the Code Lists dialog.
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Validating Data

Against Code  For print transiation objects, you can use code list tablesto validate an
List Tables element for compliance checking.

Complete the following steps to validate data against a code list table;

1. Double-click the element for which you need to validate data against a
code table. The Field Properties dialog is displayed.

| 1zl 'epoitizs

- [

D ezcription |un|r OR BA4SIS FOR MEASUREMEMT CODE Canc=l
ala Y aldeton Bdvancad =3
Win Max  Tppe Screen Famal EDI Format —
T Mandalos [2 [2 [coieg (2] [ [+ Sl

Click Advanced>>

2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Use Code option.

Adrorced

[+ LUza Standard Fuls
) Gelec! O] Updale O Conatent ©) Uee Accum © Loop Count ) Use Cade

e | g

r ExcliEive

Stars Fisd | [2]

4. Fromthe Tablelist, select the code list table that the datain this element
isvalidated againgt. If the Tableslist is empty, you need to load a code
table. Please see Loading a Code List Table from the Sandard on page
157 for more information.
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If you need to specify that the element must contain one of the codes
from the specified table (nothing elseisvalid for that element), click the
Exclusive check box.

For example, if the element is defined as containing only “YES’ or
“NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receivea“MAYBE" in that el ement, the system
will flag it as an error.

Click OK to add this standard rule to the element.

Loading Code

[tem Loading code item descriptionsis typically only done for print translation

Descriptions °biets:
Complete the following steps to load a code item description:

1

Double-click the element for which you need to load a code item
description. The Field Properties dialog is displayed.

In the Advanced section, click the Use Standard Rule check box.
Click the Use Code option.

From the Table list, select the code list table that the dataiin this element
will be validated against. If the Tableslist is empty, you need to load a
code table. Please see Loading a Code List Table from the Sandard on
page 157 for more information.

If you need to specify that the element must contain one of the codes
from the specified table (nothing elseisvalid for that element), click the
Exclusive check box.

For example, if the element is defined as containing only “YES” or
“NO,” you can set up an exclusive code table that contains only YES
and NO. Then if you receivea“MAY BE” in that element, the system
will flag it asan error.

From the Store Field list, the element to which you want the description
of the code item (that is used) to be mapped to when the selection is
made.

For example, if the code you used is“BPR” it would be useful to view the
description of the code (“Buyer's Part Number”). If you selected
element “0350” from the Store Field list, the description for the BP code
is mapped to element “0350.”

Click OK to add this standard rule to the element.
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Extended rules enable you to use a Sterling Gentran:Director proprietary
programming language to perform virtually any operation you require. You
can use these rules to define more complex translations than are available
through the standard rules.

This chapter explains how to use extended rules, including the following
topics:

e Introducing extended rules

*  When rules are processed

» Defining extended rules

»  Extended rule syntax

e Languagereference
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Declarations
Section

You can use extended rules to define operations that are not possible using

standard rules. You define extended rules with the Sterling Gentran:Director
proprietary programming language. Thisisafull programming language that
givesyou accessto the entire Sterling Gentran:Director internal storage area.

Any variables that are not already defined as part of the specification of the
form, that you use in arule must be declared before you use those variables.
Therefore, an extended rule consists of two sections, a declarations section
followed by a statements section. The declarations section isonly required if
you use additional variables. Thisiswhere you declare the names and types
of any variables you use either in thisrule or in any other rule that iswithin
the scope of thisrule. The statements section iswhere you define the actions
that you want the rule to execute.

The variables that you define in the declarations section are used to store
values. Variables consist of a name and a data type. Variable names can
include alphanumericsand the“:” and “_" characters. Thefirst character ina
variables name may not be anumeric. Please note that al variable namesare
case-sensitive.

A declaration must beterminated with a semicolon (;).
To improve readability, you typically include a blank
linein between the declaration and statement sections.

The data types that are supported by extended rules are the following:

* Integer —isawhole number with no decimal component.

* Real —isawhole number that may have adecimal component.

e String — contains one or more printable characters.

» Datetime — contains a date or time.

» Array —defines atable of multiple occurrences of asingle datatype.
Examples of declarations of variables of each datatype are as follows:

e Declarei asan integer

integer i;

* Declarer asarea number
real r;

 Declared asadate or time
datetimed;
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» Declare s asa20-character string
string[20] s;

* Declareaasan array of 10 integers
integer a[10];

» Declarep asan array of 50 10-character strings
string[10] p[50];

Statements

Section  The actual work performed by an extended rule is defined in the statements
section. A rule consists of a statement or a combination of statements (to
perform more complex operations). A statement is a single operation that
consists of a combination of expressions, keywords, commands, operators,
and symbols.

An expressionisalogica unit (e.g., A =B or A + B) that the system
evaluates. The statements section consists of a sensible combination of

keywords, operators, and symbols. Each of these componentsisexplainedin
detail in Extended Rule Syntax on page 174.
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When Rules are Processed

You can specify pre- and post-session rules on the Session Rules dialog. Pre-
session extended rules are processed before the translation object, and arein
scope for every extended rule defined in the trandlation object. Post-session
rules are executed after the translation object is processed.

Additionally, you can attach extended rules to two different levels of form
components:

»  Groups, sub-groups, repeating segments, and repeating segments, using
the Loop Level Extended Rule dialog.

* Fieldsand elements, using the Field Level Extended Rule dialog.

The scope of an extended rule determines which variables are accessible
from within a given extended rule. The scope varies depending on the
current state of the form. The scope of an extended ruleis defined asfollows:

*  Pre-session extended rules (defined on the Session Rules dialog) arein
scope for every rule in the transl ation object.

*  On New, On Store, On Open, and On Delete extended rules (defined on
the Loop Level Extended Rules dialog) are in scope until the conclusion
of the corresponding action (creating a new group, storing a group,
opening an existing group, and deleting a group).

» Field level extended rules are only in scope for the duration of the
element.

An extended rule attached to the current form component depends on the
type and state of the form component. For example, if a current group to
which theruleis attached is subordinate to another group, the parent group is
automatically in scope for the duration of the entire child group, and the
current hierarchical structureis also in scope for the duration of the child by
using an addressing method that is explained on page 176. An extended rule
that is attached to an element is only in scope for the duration of the element.
Field level extended rules are aways processed after standard rules.

A variableis considered to be “in scope” if it was declared in the current rule
or inthe Pre-Session rule.

The trandator builds the data storage area for aform based on the EDI
structure. Therefore, extended rules address the form based on the hierarchy
of the EDI file.
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The tranglator processes screen entry formsin the following manner:

1

4.

Reads the data into the Document Editor and processes all cumulative
standard rules (e.g., accumulators, etc.). Does not process any extended
or non-cumulative standard rules).

Executes group level extended rulesin the following situations:

*  On_New when anew group is created

*  On_Open when an existing group is edited
* On_Storewhen agroupissaved

* On_Deetewhen agroup is deleted

Executes field level rulesin the following sequence when focus is lost
from thefield:

*  Non-cumulative standard rules
e Extended rules

When the form is saved or recalculated, all standard rules are executed.

The tranglator processes print formsin the following manner:

1.

Reads the data and processes all cumulative standard rules (e.g.,
accumulators). Does not process any extended or non-cumulative
standard rules).

Executes group level extended rulesin the following situations:

e On_New just prior to printing a group

* On_Storejust after printing a group

Executes field level rulesin the following sequence after the field is
printed:

*  Non-cumulative standard rules

* Extendedrules
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Defining Extended Rules

The form component that an extended rule accesses depends on what you
want the scope of the rule to be. You also need to determine when you want
the rule to be executed (e.g., before or after the form component is
processed.

The process you need to follow to define an extended rule varies dightly,
depending on whether you are defining asession rule or arule for aform
component. You can define extended rules to access three different levels of
form components.

Complete the following stepsto define a session rule:

1. To specify apre- or post-session rule, select Session Rules from the Edit
menu. The Session Level Extended Rules dialog is displayed.

Chesannm | rwel TCxlerale] Tioles
( ] Prc-smaﬁ:-n_) CD Post-ae£ion )

E ditor
i ak
hi

= 1 *

Compie Emorg

Click the Pre-session option to Click the Post-session option to

define a pre-session rule define a post-session rule
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6.

If you want to define a pre-session rule, click the Pre-session option. If
you want to define a post-session rule, click the Post-session option.
Pre-session extended rules are processed before the trandation object,
and are in scope for every extended rule defined in the trandation
object. Post-session rules are executed after the trandlation object is
processed.

You can define both a Pre-session and a Post-session rule for the agiven
session.

In the Editor list, type the extended rule.

If you want to check the rule for errors, click COVPI LE to compile the
extended rule. Any warnings or errors are displayed in the Errorslist.

This function gives you immediate feedback about the accuracy of your
rule. Regardless, the rule is compiled when you compile the entire
tranglation object.

Correct any errors that the system flagged and click COVPI LE again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule,

Complete the following steps to define an extended rule for aform
component:

1

Click the form component with the right mouse button to access the
shortcut menu. Select Rules... (or Extended Rule... if the form
component is afield or element) from the shortcut menu.

« If theform component is an EDI file, group, sub-group, repeating
segment, the Loop Level Extended Rules dialog is displayed.

» If theform component isan element, the Field Level Extended Rule
dialog is displayed.
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i Loop Level Extended Rules [ (O] =]

Click an option ( & v OnStore 1 O Hpen 1 Oy Delete )
Editar

\;J o
Cancel

Type the rule in
the Editor list

[l

Compile

4 A

Compile Errars

i Field Level Extended Rule _ (O] =]
Bule

Cancel

[ e |

Type the rule in the
Editor list — Campile

Jd .

Compile Errars
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If you are defining the rule for a group, complete this step, otherwise
proceed to step 3. If you want the extended rule to be executed when
you create a new group in the translation object, click the On New
option. If you want the rule to be executed when you store agroup, click
the On Store option. If you want the extended rule to be executed when
you open an existing group, click the On Open option. If you want the
extended rule to be executed when you delete a group, click the On
Delete option. You can define an On New, On Store, On Open, and On
Deleterule for asingle group.

In the Editor list, type the extended rule.

If you want to check the rule for errors, click COVPI LE to compile the
extended rule. Any warnings or errors are displayed in the Errorslist.

This function gives you immediate feedback about the accuracy of your
rule. Regardless, the rule is compiled when you compile the entire
tranglation object.

Correct any errors that the system flagged and click COVPI LE again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule,
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Keywords and
Commands

174

The statements section of an extended rule consists of asensible
combination of keywords, operators, and symbols. The correct syntax for
each of these component is explained below.

You use spaces and operators to separate keywords and symbols. You cannot
string two keywords sequentially together without an operator.

May 2011

A keyword isafixed defined use of aword that indicates how the
programming language should be interpreted. There are two types of
keywords. Thefirst type of keyword controls the flow of execution of the
defined rule. These keywords are used to evaluate conditions and perform
looping operations. The second type of keyword is a command. Commands
perform actions on variables and are responsible for the movement of data.
A list of Sterling Gentran:Director execution control keywordsis as follows:

- IF

« THEN

« ELSE

* BEGIN

« END

«  WHILE

« DO

+ CONTINUE
* BREAK

A list of Sterling Gentran:Director commands is as follows:
« GET

« SET

« STRDATE
+ CONCAT
* LEN
 ATOI

« ATON

» EMPTY

« EXIST
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Operators

Symbols
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* INDEX

« NTOA

+ COUNT
« DELETE
e LEFT

*  RIGHT

* MID

« SELECT
« UPDATE

” A statement must be terminated with a semicolon (;).

Operators define the simplest operation in an expression. You can use the
following operators in extended rules:

+ addition, concatenation
- subtraction

*  multiplication

[/ division

= assignment, equality
>  greater-than

< lessthan

>= greater-than or equal to
<= less-than or equal to
I=  not equal to

I logical not

& logical and

| logical or

<< date modification

Operations are performed on symbols. The symbols that you can use in
Sterling Gentran:Director extended rules are variables, constants, form
components/internal storage, arrays, and accumulators. You can address
existing form components and you also have the ability to create additional
instances of form components, as long as the form component is originally
defined in internal storage. You can use this function to create, for example,
extralineitems when onelineitem field is already defined in interna
storage. You must address each type of symbol in the proper syntax.
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To address a string constant, you must enclose the constant valuein
quotes:

#fieldname="HDR";

where HDR is the constant value

To address afield or create afield in internal storage, within the scope
of the current action, the syntax is#FIELD_NAME

#ield_1=2;

where 2 isa numeric constant value

To address afield within agroup or create afield within agroup in
internal storage within the scope of the current hierarchy, the syntax is
$GROUPHFIELD NAME

SN1.#0234

To fully address agroup in the entire internal storage area or create a
group in internal storage, the syntax is $L OOP[index1][index2][index3]
where the index entries indicate the hierarchical structure of the loop
and enable you to address specific instances of a group:
$Group_C[3][2] #Field_2

where you are specifying the second instance of Group_C within the
third instance of Group_B:

Group A

Group B

Group C

1 2 3/
To address an array (of any type), you address each element of the array
individually. For example, if array_1isan array (of integers) and is
declared:
integer array_1[5]
with variables 0 through 4, each element of the array is addressed
individually asfollows:

array_1[0]
array_1[1]

IBM Sterling Gentran:Director Forms Integration User Guide



Using Extended Rules

Extended Rule Syntax

Common
Statements and
Examples

Assignment

array_1[2]
array _1[3]
array_1[4]

An accumulator can be accessed in the same manner as variables or
internal storage. To address an accumulator, use the syntax accum(n)
where “n” isthe number (not the name) of the accumulator:
accum(2) = 5;

An example of asimple statement is as follows:

keywords

operator

| SSGroup_Name.#Field_Name| i#FieId_Namelz;

symbols

Some of the common statements are as follows:

gnment

datetime expressions
conditional logic

string conditions and functions
numerical functions

raise compliance error function
remove field value function
existence of data function

The assignment statement is the most powerful and most often used
extended rule statement. In the most simple form, it is written as follows:

variable=expression
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Datetime
Expressions

However, you can use this statement in more flexible and complex ways,
defined asfollows:

numeric_variable=numeric_expression
numeric_field=numeric_expression
string_variable=string_expression
string_field=string_expression
datetime_variable=datetime_expression
datetime_field=datetime_expression

A numeric expression can consist of number, numeric fields, numeric
variables, and numeric functions combined with the standard arithmetic
operators. A string expression can consist of string constants, string fields,
string variables, and string functions concatenated with the “+" operator. A
datetime expression can consist of a datetime constant, datetime field or
datetime variable.

Some examples of assignment expressions are as follows:

a=5;
a=b+c;

s="hdlo";
s=s+"world";

Datetime expressions consist of a datetime variable and (optionally)
datetime modifiers. Datetime expressions can be written using datetime
constants if you are using the standard syntax, as follows:

year/month/day
hour:minute:second
year/month/day/hour :minute: second

Datetime expressions can aso be written with datetime fields, variables, or
using date and time functions. Date functions are written as follows (month
specified as 0-11):

datetimed;

d = date(1995,4,6);

d = date(1995,4,6,12,0);

d = date(" %y/% m/%d", " 95/4/6");

Thed =date(" %y/% m/%d", " 95/4/6"); format enables you to convert
any string format type into a datetime format type by indicating a format
mask (" %Yy/%m/%d") along with the string (" 95/4/6" ) you want to
convert. You use thisfunction if you are using non-standard syntax and need
to specify the syntax you are using.
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Conditional Logic

You can use the << operator to modify your datetime variable by adding time
increments (e.g., days, weeks, years). For example:

datetimed;
d=d <<weeks(2);
/IThis adds 2 weeksto d.

Time functions are written as follows:

d = time(12,0);
d = time(12,0,59);

You can use the << operator to modify your datetime variable by adding time
increments (e.g., seconds, minutes, years). For example:

datetimed;
d=d <<seconds(1);
/IThisadds 1 second to d.

The get and set functions enable you to access (get) or modify (set)
individual components of a datetime type. These functions are used as
follows:

integer a;
datetimed;

a = get days (d);
a = get hours(d);
set hour (d,a);
set days (d,a);

Sterling Gentran:Director uses conditional logic to test conditions and then,

depending on the results of the test, perform different operations. Conditions
can be nested to any level. Do not end conditions with a semicolon (;) —this
terminating syntax is necessary for statements only.

You can use the IF/THEN keywords to execute one or more statements
conditionally. The condition is typically acomparison, but it can be any
expression that concludes with anumeric value. Sterling Gentran:Director
interprets the value as either true or false. The system interprets a zero value
asfalse and anonzero value as true.

If you include more than one statement in the body of
an I[F/THEN loop, you must surround the statements
with the BEGIN/END keywords. If you only use a
single statement, you can omit the BEGIN and END.

Sterling Gentran:Director evaluates the IFF'THEN condition, and if it istrue,
the system executes all the statements that follow the THEN keyword. If the
condition is false, none of the statements following THEN are executed.
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You can use the EL SE keyword in conjunction with IF/THEN to define
several blocks of statements, one of which is executed. Sterling
Gentran:Director tests the first IFFTHEN condition. If the condition is false,
the system proceeds to test each sequentia condition until it finds onethat is
true. The system executes the corresponding block of statements for the true
condition. If none of the IF/THEN conditions are true, the system executes
the statements following the EL SE keyword. The IF/ THEN/EL SE statement
iswritten asfollows:

IF condition THEN

BEGIN
statementl;
statement2;

END

ELSE

BEGIN
statement3;
statement4;

END

An example of when you may use conditional logicisif you need to evaluate
whether an N1 or NAD group contains billing or shipping information (this
depends on the qualifier that afield in the group contains), and then map that
information to the appropriate application fields. For this example, you need
to add an On End extended rule to the NI/NAD. Theruleis executed when
the group terminates. An example of the syntax of the rule follows:

IF #0098 =" BT" THEN

BEGIN
$Group_Name#BILLTONAME = #0093;
$Group_Name. #BILLTOADDRL1 = #0166;
$Group_Name#BILLTOADDR2 = #0166:2;
$Group_Name#BILLTOCITY =#0019;
$Group_Name#BILLTOSTATE = #0156;
$Group_Name. #BILLTOPCODE = #0116;

END

IF #0098 =" ST" THEN

BEGIN
$Group_Name#SHIPTONAME = #0093;
$Group_Name#SHIPTOADDRL = #0166;
$Group_Name#SHIPTOADDR2 = #0166:2;
$Group_Name#SHIPTOCITY = #0019;
$Group_Name#SHIPTOSTATE = #0156;
$Group_Name#SHIPTOPCODE = #0116;

END
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String Conditions You can use string conditionsin IF/THEN and | F/THEN/EL SE statementsto
and Functions perform comparisons between strings. Examples of the syntax are as

follows:

IFs1=s2THEN
IFS1<s2THEN
IFs1>s2THEN

The following string functions are also available for you to use:

left
right
mid
strdate
concat
strstr

5 O3 5 S 35 S

The left, right, and mid functions enable you to extract substrings from a
string. The left function extracts a specified number of characters from the
left of the string. The right function extracts a specified number of character
from the right of the string. The mid functions extracts from a specified
position in the string to the right, either to the end of the string or for a
specified number of characters. These statements are used as follows:

string[1Q] s;
string[3] s1;
string[3] s2;
string[4] s3;
string[7] s4;

s="abcdefghij";

sl = left(s,3);

s2 =right(s,3);

s3 =mid(s,3,4);

A4 =mid(s,3);

The strdate functions converts a datetime type into a string using a format
that you specify. Thisfunction allowsyou to include static characters such as
adlash (/), which gives you access to full date support. The syntax isas
follows:

datetimed,;
string[8] s;

strdate(d,” %y/% m/%d" ,9);

IBM Sterling Gentran:Director Forms Integration User Guide May 2011 181



Extended Rule Syntax Using Extended Rules

The concat function concatenates a specified number of characters from one
string onto the end of another string. The following example demonstrates
the syntax to concatenate five characters from string “s2” onto the end of
string “s1”:

string[10] s1,s2;

concat(sl,s2,5);

The strstr function finds a substring inside a string. This function returns the
position of the first instance of the designated substring. The syntax is as
follows:

integer d;

d =strstr (" hello", " el");

Numerical Thenumerical functions enable you to convert one data type to another. The
Functions numerical functionsthat are available for you to use are the following:

len
atoi
aton
ntoa

5 5 35 S

The len function counts and returns the number of charactersin astring. An
exampleisasfollows:

integer a;

a=len("helo");

The atoi function converts strings into integers. The aton function converts
string into real numbers. The ntoa function converts real numbersinto
strings. An exampleisafollows:

integer a;

real b;

string[8] s;

a=atoi("5");

b =aton("5.5");

ntoa(5.5, );

Remove Field The empty function sets the value of afield in internal storage to null. This
Value Function function is not the same as setting the value of afield to azero length string
(EMPTY) ("")orto zero. The syntax is as follows:

empty($! L D[0][1][1] #VATC);
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Existence of Data
Function (EXIST)

Count Function
(COUNT)

Delete Function
(DELETE)

Select Function
(SELECT)

The above example sets the value of the specified instance of the VATC
element to null. When this function is used in expressions, the null valueis
propagated if any part of the expression is evaluated to be null. Thisfunction
istypically used to test whether or not an error occurred.

The exist function returns anon-zero (true) value if thereisdatain a
specified field in internal storage. If there is not datain the specified field,
this function returns a zero (false) value. Thisfunction istypicaly used asa
part of a condition. The syntax is as follows:

IF exist($|LD[O][1][1] #VATC) THEN

The above example returns a non-zero value if the condition istrue (datais
present in the specified instance of the VATC element). A zerovalueis
returned if the condition isfalse (no datais present in the specified instance
of the VATC element).

There are some situations (for example, if the field or element hasa"Use
Code" standard rule applied to it) when the IF EXIST returns a non-zero
(true) value whether or not the condition istrue. You can work around this
by only using IF EXIST for date- and number-type fields. Be certain that all
references to the field which isinterrogated are nested within the IF EXIST
begin block. For string-type fields, use the following format:

IF Fieldl=""

The count function returns the total number of times a group (or repeating
record) hasiterated. The syntax is asfollows:

count(GROUPNAME[3][*]);

The above example returns the total iterations of the GROUPNAME group
within the third iteration of the parent group.

The delete function deletes the specified iteration of arepeating record or
group. The syntax is asfollows:

delete(GROUPNAM EJiteration]);

The select function alows information to be retrieved from the database
tables. Only the tables and fields available in the Select standard rule are
available for the select extended rule. In the command syntax “expression”
and “receiverlist” can be astring field, string variable, or string literal. It is
important to note that the table and field names for the select extended rule
are dightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.
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Update Function

184

(UPDATE)

The syntax is asfollows:

select fieldname into receiverlist from tablename wher e key = expression
[and key = expression];

The update function allows information in the database tables to be updated.
Thisfunction is similar to the Update standard rule, except that it provides
more flexibility. Only the tables and fields available in the Update standard
rule are available for the update extended rule. In the command syntax
“expression” can be astring field, string variable, or string literal. It is
important to note that the table and field names for the update extended rule
are dightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter. The
syntax isasfollows:

update tablename set fieldname =expression [fieldname =expression]
where key = expression [and key = expression];
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Alphabetic Language Reference

atoi

This section contains an al phabetic reference for the Sterling
Gentran:Director proprietary programming language keywords and
commands. This enables you to quickly and easily refer to information on
specific keywords or commands. This section uses the following

conventions:

While Bold typeface is used to express what you need to
type.

condition In syntax, italic lettersindicate information that you
need to provide.

[1] In syntax, items inside square brackets are optional .

The following programming guidelines are utilized in this section:

n Keywords and commands are shown in all lower case letters.
n Form components are shown in all upper case letters.

n A double slash (/) introduces comments.
n

Linesthat are too long to fit on oneline in this section may be continue
on the next line using a line-continuation character (A).

The atoi function is anumerical function that converts strings into integers.
The numerical functions enable you to convert one data type to another.

The syntax is asfollows:
int = atoi(string);

where: int = integer variable
string = string variable

An exampleisasfollows:

integer a;
string[20] s;

s="5";
a=atoi(s);
/I"a" containsthevalue5b
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aton

begin

The aton function is a numerical function that converts strings into real
numbers. The numerical functions enable you to convert one data type to
another.

The syntax is asfollows:
real = aton(string);

where: rea = real number variable
string = string variable

An exampleisasfollows:

real b;
string[20] s;

s="55";
a = aton(s);

/I"a" containsthevalue5.5

Sterling Gentran:Director uses conditional logic to test conditions and then,
depending on the results of the test, perform different operations. Conditions
can be nested to any level. You can use the if/then keywords to execute one
or more statements conditionally. If you include more than one statement in
the body of an if/then loop, you must surround the statements with the
begin/end keywords. If you only use a single statement, you can omit the
begin and end.

Do not end conditionswith a semicolon (;) —this
terminating syntax is necessary for statements only.

The syntax is asfollows:

if condition then
begin
Sstatementl;
statement2;
end
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break

concat

The break function terminates the execution of the nearest enclosing while
loop, and passes control to the statement that follows the end keyword. The
break keyword is generally used in complex loops to terminate aloop
before several statements have been executed.

An exampleisasfollows:

integer i
integer j;

i :j =0;
whilei<10 do
begin
if (i = 8) then
continue;
if (i =9) then
break;
end

/[Aslong as"i" hasavaluelessthan " 10" theloop repeats. If "i" has
/lavalueof "i", theloop continues. If "i" hasavalue
/lof " 9" theloop terminates.

The concat function concatenates a specified number of charactersfrom one
string onto the end of another string.

The syntax is asfollows:
concat(string,string,num_char);

where: string = string variable
num_char = number of characters from the second string onto the
end of thefirst string

An exampleisasfollows;
string[10] s1,82;
concat(sl,s2,5);

/IConcatenate five charactersfrom string " s2" onto the end of string
/" s1"
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continue

count

delete

The continue function continues the execution of the innermost loop
without processing the statements in the loop that follow the continue
statement.

An exampleisasfollows:

integer i
integer j;

i :j =0;
whilei<10 do
begin
if (i = 8) then
continue;
if (i =9) then
break;
end

/[Aslongas"i" hasavalueof "8" theinnermost loop repeats. | f
/ldoes not have avalue of " 8" the next statement (break statement)
/lis processed.

The count function counts and returns the number of iterations of a group.
An exampleisasfollows:

integer i;
i = count($N1[*]);

/[The[*] isawildcard that countsthe number of iterations of the N1
/lgroup.

The delete function deletes a specified occurrence of a group.
The